Ion PI™ Sequencing 200 Kit v2

for use with:
Ion Proton™ System
Ion PI™ Chip v2

Catalog Number  4485149
Publication Number  MAN0007961
Revision  3.0
For Research Use Only. Not for use in diagnostic procedures.

The information in this guide is subject to change without notice.

DISCLAIMER

LIFE TECHNOLOGIES CORPORATION AND/OR ITS AFFILIATE(S) DISCLAIM ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT. TO THE EXTENT ALLOWED BY LAW, IN NO EVENT SHALL LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

Trademarks

The trademarks mentioned herein are the property of Life Technologies Corporation and/or its affiliate(s) or their respective owners. Rainin and Pipet-Lite are registered trademarks and StableRak is a trademark of Rainin Instruments, LLC. Elga and PURELAB are registered trademarks of VWS, LLC. MAXYMum Recovery is a registered trademark of Axygen Inc. Pipet-Aid is a registered trademark of Drummond Scientific Company. Tygon is a registered trademark of Saint-Gobain Performance Plastics. Microsoft and Excel are registered trademarks of Microsoft Corporation. Triton is a registered trademark of Union Carbide Corporation. Orion is a registered trademark of Thermo Orion, Inc.

© 2013 Life Technologies Corporation. All rights reserved.
Contents

About This Guide ........................................................... 7
Revision history ................................................................. 7
Purpose of the guide ............................................................ 7

■ CHAPTER 1  Product information ........................................... 8
Product description ............................................................. 8
Library kit compatibility .......................................................... 8
Template kit compatibility ......................................................... 8
Software compatibility ........................................................... 9
Workflow ...................................................................... 9
Ion PI™ Sequencing 200 Kit v2 contents and storage ......................... 9
Required materials and equipment .............................................. 11
Ion Proton™ Sequencer ......................................................... 13
Precautions - Read before using the Ion Proton™ System ...................... 14
   Gas safety ................................................................ 14
   Avoid nucleic acid contamination ........................................ 14
   Avoid CO₂ contamination ............................................. 14
   Avoid introducing noise to instrument measurements .................... 15
   Avoid chip damage ..................................................... 15

■ CHAPTER 2  Create a Planned Run ........................................... 16
About planned runs ............................................................. 16
Create a planned run ........................................................... 16
Planned run wizard: key fields .................................................. 18

■ CHAPTER 3  Clean and Initialize the Ion Proton™ Sequencer .......... 20
Ion Proton™ Sequencer reagent positions ....................................... 20
Before you begin .................................................................. 20
Clean the Ion Proton™ Sequencer ............................................... 21
   Materials required ......................................................... 21
   Cleaning schedule .......................................................... 21
   18 MΩ water cleaning ................................................... 22
   Chlorite cleaning .......................................................... 23
CHAPTER 4  Load the Ion PI™ Chip v2 and start the sequencing run ................................................................. 28

Before you begin ............................................................... 31

Prepare and calibrate the Ion PI™ Chip v2 for loading .................. 33
Prepare the chip for loading ................................................ 33
Optional: Store the prepared chip ....................................... 34
Calibrate the chip .......................................................... 35

Load the Ion PI™ Chip v2 ............................................................ 35
Load the sample on the chip ................................................. 35
Flush the chip and load the Ion PI™ Sequencing Polymerase .......... 36
Select the planned run and start the sequencing run ..................... 37

APPENDIX A  Troubleshooting ................................................................. 38

Alarms and events ............................................................... 39
Status bar icon warnings .................................................... 40
Instrument leaks ............................................................... 42
Touchscreen ................................................................. 43
Instrument error messages .................................................. 43
Sample loading or sequencing ................................................. 49
Troubleshooting using the Ion PI™ Control Ion Sphere™ particles .............. 50

APPENDIX B  Barcoded Libraries ............................................................ 51

Pre-installed barcode sets ................................................... 51
Select a barcode set for a sequencing run ................................ 51
Custom barcode sets ........................................................... 51
Contents

Environmental design .............................................................. 69
Chemical safety ......................................................................... 70
Specific chemical handling .......................................................... 70
Biological hazard safety ............................................................. 71

Documentation and Support ..................................................... 72

Obtaining Certificates of Analysis ............................................. 72
Obtaining SDSs ......................................................................... 72
Obtaining support ........................................................................ 72
Ion contact information .............................................................. 72
Limited product warranty ............................................................ 73
IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix in this document.

## Revision history

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0</td>
<td>11 Sept 2013</td>
<td>Includes reference to new Ion PI™ Loading Buffer XT (Part no. 100021655) included in the Ion PI™ Reagents XT Kit (Cat. no. 4487053) for Ion AmpliSeq™ Exome libraries.</td>
</tr>
<tr>
<td>2.0</td>
<td>1 July 2013</td>
<td>Support for Ion AmpliSeq™ Exome libraries added.</td>
</tr>
<tr>
<td>1.0</td>
<td>15 May 2013</td>
<td>New user guide.</td>
</tr>
</tbody>
</table>

## Purpose of the guide

The Ion PI™ Sequencing 200 Kit v2 User Guide (Pub. no. MAN0007961) provides protocols and reference information for using the Ion PI™ Sequencing 200 Kit v2 (Cat. no. 4485149) with the Ion PI™ Chip Kit v2 (Cat. no. 4482321).
Product description

The Ion PI™ Sequencing 200 Kit v2 includes reagents and materials for sequencing up to 200-bp average insert libraries using the Ion PI™ Chip Kit v2 (Cat. no. 4482321) on the Ion Proton™ System. The sequencing kit also includes components for cleaning and initializing the instrument.

The Ion PI™ Sequencing 200 Kit v2 is designed to sequence templates that have been amplified on Ion PI™ Ion Sphere™ Particles (ISPs) using the Ion PI™ Template OT2 200 Kit v2 (Cat. no. 4485146). Sufficient reagents and materials are provided for performing eight initializations and eight sequencing runs.

<table>
<thead>
<tr>
<th>Sequencing type</th>
<th>Number of flows</th>
<th>Number of runs per kit</th>
<th>Average run time</th>
</tr>
</thead>
<tbody>
<tr>
<td>200-base-read</td>
<td>500</td>
<td>8</td>
<td>3.2 hours</td>
</tr>
<tr>
<td>150-base-read</td>
<td>400</td>
<td>8</td>
<td>2.6 hours</td>
</tr>
<tr>
<td>100-base-read</td>
<td>260</td>
<td>8</td>
<td>1.8 hours</td>
</tr>
</tbody>
</table>

Note: Some applications allow for shorter flow times and shorter read lengths. The number of flows can be reduced in increments of 20. Contact Technical Support for more information.

Library kit compatibility

The Ion PI™ Sequencing 200 Kit v2 can be used with up to 200-bp average insert libraries of any type prepared using any available Ion library kit.

Template kit compatibility

The Ion PI™ Sequencing 200 Kit v2 must be used with the Ion PI™ Template OT2 200 Kit v2 (Cat. no. 4485146).
Software compatibility

This sequencing kit is compatible with Torrent Suite Software Version 3.6.2 and later. Be sure to update your software before using this kit.

Workflow

Use the following workflow to perform sequencing runs with the Ion Proton™ System.

Chapter 2, “Create a Planned Run”

▼

Chapter 3, “Clean and Initialize the Ion Proton Sequencer”

“Clean the Ion Proton Sequencer” on page 21

▼

“Initialize the Ion Proton Sequencer” on page 24

▼

Chapter 4, “Load the Ion PI Chip v2 and start the sequencing run”

“Prepare the template-positive Ion PI Ion Sphere Particles for sequencing” on page 32

▼

“Prepare and calibrate the Ion PI Chip v2 for loading” on page 33

▼

“Load the Ion PI Chip v2” on page 35

▼

“Select the planned run and start the sequencing run” on page 37

Ion PI™ Sequencing 200 Kit v2 contents and storage

IMPORTANT! Do not mix components with components from any other Ion sequencing kits. Life Technologies has validated this protocol using these specific materials. Substitution may adversely affect system performance.

The Ion PI™ Sequencing 200 Kit v2 (Catalog no. 4485149) contains 5 boxes:

- Ion PI™ Sequencing Supplies 200 (Part no. 4482282)
- Ion PI™ Sequencing Reagents 200 (Part no. 4482284)
- Ion PI™ Sequencing Solutions 200 v2 (Part no. 4485521)
- Ion PI™ Chip Preparation Solution (Part no. 4484082)
- Ion Proton™ Chip Adapters (Part no. 4485416)
### Ion PI™ Sequencing Supplies 200 (Part no. 4482282)

<table>
<thead>
<tr>
<th>Components</th>
<th>Color</th>
<th>Quantity</th>
<th>Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ion Proton™ Reagent Tubes with labels (140 mL)</td>
<td>—</td>
<td>64</td>
<td>—</td>
<td>15°C to 30°C</td>
</tr>
<tr>
<td>Ion Proton™ Reagent Tube Caps</td>
<td>—</td>
<td>64</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ion Proton™ Reagent Tube Sippers</td>
<td>Blue</td>
<td>64</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ion Proton™ Wash 2 Bottles with labels (2 L)</td>
<td>—</td>
<td>2</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ion Proton™ Wash Bottle Sippers</td>
<td>Gray</td>
<td>8</td>
<td>—</td>
<td></td>
</tr>
</tbody>
</table>

### Ion PI™ Sequencing Reagents 200 (Part no. 4482284)

<table>
<thead>
<tr>
<th>Components</th>
<th>Color</th>
<th>Quantity</th>
<th>Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ion PI™ dGTP</td>
<td>Black</td>
<td>1 tube</td>
<td>240 µL</td>
<td>~30°C to ~10°C</td>
</tr>
<tr>
<td>Ion PI™ dCTP</td>
<td>Blue</td>
<td>1 tube</td>
<td>240 µL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ dATP</td>
<td>Green</td>
<td>1 tube</td>
<td>240 µL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ dTTP</td>
<td>Red</td>
<td>1 tube</td>
<td>240 µL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ Sequencing Polymerase</td>
<td>Yellow</td>
<td>1 tube</td>
<td>48 µL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ Sequencing Primer</td>
<td>White</td>
<td>1 tube</td>
<td>160 µL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ Control Ion Sphere™ particles</td>
<td>Clear</td>
<td>1 tube</td>
<td>40 µL</td>
<td></td>
</tr>
</tbody>
</table>

### Ion PI™ Sequencing Solutions 200 v2 (Part no. 4485521)

<table>
<thead>
<tr>
<th>Components</th>
<th>Color</th>
<th>Quantity</th>
<th>Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ion PI™ W2 Solution v2</td>
<td>—</td>
<td>2 bottles</td>
<td>320 mL each</td>
<td>2°C to 8°C Store W2 Solution v2 protected from light.</td>
</tr>
<tr>
<td>Ion Proton™ Cleaning Tablet</td>
<td>—</td>
<td>8 tablets</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ 1X W3 Solution</td>
<td>—</td>
<td>1 bottle</td>
<td>400 mL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ Annealing Buffer</td>
<td>—</td>
<td>1 bottle</td>
<td>30 mL</td>
<td></td>
</tr>
<tr>
<td>Ion PI™ Loading Buffer</td>
<td>Brown</td>
<td>1 tube</td>
<td>80 µL</td>
<td></td>
</tr>
</tbody>
</table>

### Ion PI™ Chip Preparation Solution (Part no. 4484082)

<table>
<thead>
<tr>
<th>Components</th>
<th>Quantity</th>
<th>Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ion PI™ Chip Preparation Solution</td>
<td>2 vials</td>
<td>1.3 mL each</td>
<td>~30°C to ~10°C</td>
</tr>
</tbody>
</table>

### Ion Proton™ Chip Adapters (Part no. 4485416)

<table>
<thead>
<tr>
<th>Components</th>
<th>Quantity</th>
<th>Volume</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ion Proton™ Chip Adapters</td>
<td>8 adapters</td>
<td>—</td>
<td>15°C to 30°C</td>
</tr>
</tbody>
</table>
Required materials and equipment

The following tables list required materials and equipment that are not provided with the Ion PI™ Sequencing 200 Kit v2.

**Note:** Life Technologies has validated this protocol using these specific materials. Substitution may adversely affect system performance.

### Table 1  Required materials and equipment for sequencing

<table>
<thead>
<tr>
<th>✓</th>
<th>Description</th>
<th>Supplier</th>
<th>Catalog no.</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ion PI™ Chip Kit v2 8-Pack (2 boxes of 4 chips each)</td>
<td>Life Technologies</td>
<td>4482321</td>
<td>8 chips</td>
</tr>
<tr>
<td></td>
<td>Ion Proton™ System (instrument and server) and all included accessories</td>
<td>Life Technologies</td>
<td>4476610</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Ion Chip™ Minifuge (120 V or 230 V)</td>
<td>Life Technologies</td>
<td>4479672 (120V) or 4479673 (230V)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Ion Proton™ Rotor and Buckets Kit</td>
<td>Life Technologies</td>
<td>4482578</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Ion PI™ Controls Kit v2</td>
<td>Life Technologies</td>
<td>4482414</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Tank of compressed nitrogen (grade 4.5, 99.995% pure or better)</td>
<td>Major Laboratory Supplier [MLS]</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Multistage (dual-stage) gas regulator (0–50 psi, 2–3 Bar output)</td>
<td>VWR International</td>
<td>55850-422</td>
<td>1 or 2</td>
</tr>
<tr>
<td></td>
<td><em>(Optional)</em> 1/8” x 1/4” stem reducing coupler <em>(only required if using a separate tank for the wash station)</em></td>
<td>McMaster</td>
<td>5779K699</td>
<td>1 per wash</td>
</tr>
<tr>
<td></td>
<td>Uninterruptable Power Supply [UPS]</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Elga® PURELAB® Flex 2 Water Purification System or Elga® PURELAB® Flex 3 Water Purification System or Equivalent 18 MΩ water system</td>
<td>Life Technologies</td>
<td>4474525 or 4474524 or MLS</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>NaOH (10 M) molecular biology grade</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Isopropanol (100%)</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Nuclease-free water molecular biology grade</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Triton® X-100</td>
<td>Sigma</td>
<td>X100-5ML</td>
<td>5 mL</td>
</tr>
<tr>
<td></td>
<td>0.22-µm or 0.45-µm vacuum filtration system and filters</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Microcentrifuge</td>
<td>MLS</td>
<td>—</td>
<td>1 set</td>
</tr>
<tr>
<td></td>
<td>P2, P10, P20, P200, P1000 µL pipette set and filtered tips</td>
<td>MLS</td>
<td>—</td>
<td>1 set</td>
</tr>
<tr>
<td>Description</td>
<td>Supplier</td>
<td>Catalog no.</td>
<td>Quantity</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>25-mL or 50-mL serological pipettes or 100-mL graduated cylinder</td>
<td>MLS</td>
<td>—</td>
<td>Varies</td>
<td></td>
</tr>
<tr>
<td>(If using serological pipettes) Pipet-Aid® pipetter</td>
<td>Drummond Scientific</td>
<td>4-000-110</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Rainin® Pipet-Lite® XLS with RFID LTS 2 µL to 20 µL</td>
<td>Rainin</td>
<td>L-20XLS</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Rainin® Pipet-Lite® XLS with RFID LTS 10 µL to 100 µL</td>
<td>Rainin</td>
<td>L-100XLS</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Rainin® StableRak™ LTS tips 2-20 µL</td>
<td>Rainin</td>
<td>SR-L20F</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Rainin® StableRak™ LTS tips 200 µL</td>
<td>Rainin</td>
<td>SR-L200F</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>0.2-mL MAXYMum Recovery® Thin Wall PCR Tubes, Flat Cap (do not use polystyrene tubes)</td>
<td>Axygen</td>
<td>PCR-02-L-C</td>
<td>Varies</td>
<td></td>
</tr>
<tr>
<td>1.5-mL or 1.7-mL microcentrifuge tubes</td>
<td>MLS</td>
<td>—</td>
<td>Varies</td>
<td></td>
</tr>
<tr>
<td>Glass bottles (1 L)</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Ice buckets and ice</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Aluminum heat block, capable of maintaining 50°C</td>
<td>MLS</td>
<td>—</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Vortex mixer with a rubber platform</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Thermal cycler with a heated lid</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Standard laboratory vacuum line or vacuum pump</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Liquid trap</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Tygon® tubing [4]</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

[1] For installation and troubleshooting.
[2] For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptable power supply that is compatible with 2500 W output or higher.
[3] Must fit standard 1.5- and 0.2-mL microcentrifuge tubes and generate 15,500 × g.
[4] As needed to connect laboratory vacuum to liquid trap and liquid trap to P200 pipette tip.

Table 2  Optional materials and equipment for sequencing

<table>
<thead>
<tr>
<th>Description</th>
<th>Supplier</th>
<th>Catalog no.</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following may be required to verify and adjust the pH of the W2 Solution during Initialization</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orion® 3-Star Plus pH Benchtop Meter Kit with electrode, electrode stand, and calibration buffers (or equivalent)</td>
<td>Thermo Scientific</td>
<td>1112003</td>
<td>1</td>
</tr>
<tr>
<td>1 N HCl</td>
<td>MLS</td>
<td>—</td>
<td>Varies</td>
</tr>
<tr>
<td>Magnetic stirrer (must hold 2-L bottle)</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
</tr>
<tr>
<td>Magnetic stir bar (4 cm)</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
</tr>
<tr>
<td>Squirt bottle</td>
<td>MLS</td>
<td>—</td>
<td>1</td>
</tr>
</tbody>
</table>
**Ion Proton™ Sequencer**

*Figure 1*  Ion Proton™ Sequencer with Reagent Tubes attached

*Figure 2*  Ion Proton™ Sequencer reagent compartment
Precautions - Read before using the Ion Proton™ System

Gas safety

**WARNING!** Ion instrumentation should be installed and operated in a well-ventilated environment as defined as having a minimum airflow of 6–10 air changes per hour. Assess the need for ventilation or atmospheric monitoring to avoid asphyxiation accidents from inert gases and/or oxygen depletion, and take measures to clearly identify potentially hazardous areas through training or signage. Please contact your Environmental Health and Safety Coordinator to confirm that the Ion instruments will be installed and operated in an environment with sufficient ventilation.

**IMPORTANT!** A primary source of contamination is spurious DNA fragments from previous sample processing steps. Do not introduce amplified DNA into the library preparation laboratory or work area.

Avoid nucleic acid contamination

**IMPORTANT!** Handle nucleotides carefully to avoid cross-contamination. Always discard gloves after removing used Sippers from the Ion Proton™ Sequencer in order to avoid cross-contamination of the nucleotides. Always discard gloves after handling concentrated dNTP stocks. Barrier tips are required for all dNTPs pipetting steps.

Avoid CO₂ contamination

**IMPORTANT!** Dry ice (solid CO₂) should be kept away from areas where buffers, wash solutions or sources of molecular biology grade water for the Ion Proton™ System are used. High air concentrations of subliming CO₂ may influence the pH of such buffers during or after their preparation. The stability of the pH of these buffers is a critical factor in the performance of the Ion Proton™ System.
**Avoid introducing noise to instrument measurements**

**IMPORTANT!** Install the Ion Proton™ System on a bench that is free from vibrations and that is not in contact with freezers, pumps, or other equipment that can cause vibrations. Significant vibration during sequencing may add noise and reduce the quality of the measurements.

See the Ion Proton™ System Site Preparation Guide (Pub no. 4478733) for Ion Proton™ System space requirements and clearances.

**Avoid chip damage**

**IMPORTANT!** To avoid possible damage to the chip due to electrostatic discharge, ground yourself before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the metal trim on the chip compartment before inserting or removing a chip from the chip clamp.
IMPORTANT! This sequencing kit is compatible with Torrent Suite Software Version 3.6.2 and later. Before proceeding, check for updates to the Torrent Suite and Ion Proton™ Sequencer software, and install the updates if available.

Note: If you are currently using Ion Reporter™ Software Version 1.2 with an earlier version of the Torrent Suite Software, contact Technical Support for assistance with upgrading to Torrent Suite Software Version 3.6.2.

About planned runs

Planned runs contain all the settings used in a sequencing run, including number of flows, kit types, barcodes used (if any), run type (e.g., DNA, RNA, amplicons), and reference file (if any). They provide a fast and convenient way to set up and organize your runs.

You create planned runs using the Torrent Browser and then select the appropriate plan in the Select Planned Run screen of the Ion Proton™ Sequencer when you are ready to perform the run (see “Select the planned run and start the sequencing run” on page 37).

Note: For additional information, see the Torrent Suite User Interface Guide 3.6.2. Go to ioncommunity.lifetechnologies.com, select Products → Torrent Suite, then select Torrent Suite 3.6.2 Documentation.

Create a planned run

1. Open the Torrent Browser for the Ion Proton™ Torrent Server connected to your Ion Proton™ Sequencer.
2. Select the **Plan** tab, select **Templates**, locate the application you want to run (for example, TargetSeq) then select one of the following:

   - **Plan Run** to plan a new run using one of your existing templates.
   - **Plan New Run** to plan a new run using the generic template for the selected application.

3. In the wizard, review each screen and edit as needed. Key fields are described in “Planned run wizard: key fields” on page 18.

**Note**: For a complete description of each field, see the *Torrent Browser User Interface Guide*. 
4. When you have completed your selections, click **Plan Run** to save your selections. The run is listed on the Planned Runs page under the name you specified.

You can then select the appropriate plan when you are setting up the run on the Ion Proton™ Sequencer. Select the plan on the Select Planned Run screen (see “Select the planned run and start the sequencing run” on page 37).

![ Planned run wizard: key fields ]

### Planned run wizard: key fields

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select the sequencing application you are performing.</td>
</tr>
<tr>
<td>Run Type</td>
<td>Select <strong>Forward</strong>.</td>
</tr>
<tr>
<td>Template Kit</td>
<td>Select the kit used to prepare the templated Ion PI™ Ion Sphere™ Particles.</td>
</tr>
<tr>
<td>Sequencing Kit</td>
<td>Select the Ion PI™ Sequencing 200 Kit v2.</td>
</tr>
<tr>
<td>Flows</td>
<td>Enter the appropriate number of flows for the read length (for example, 500 flows for 200-base-read sequencing).</td>
</tr>
<tr>
<td>Barcode Set (optional)</td>
<td>If you are using barcodes with:</td>
</tr>
<tr>
<td></td>
<td>• <strong>DNA libraries</strong>: Select the <strong>IonXpress</strong> barcode set, which includes all barcodes in the Ion Xpress™ Barcode Adapters 1-96 Kits.</td>
</tr>
<tr>
<td></td>
<td>• <strong>RNA libraries prepared using the Ion Total RNA-Seq Kit v2</strong>: Select the <strong>IonXpressRNA</strong> barcode set, which contains all 16 barcodes in the Ion Xpress™ RNA BC01-16 Kit.</td>
</tr>
<tr>
<td></td>
<td>If you are <strong>not</strong> using barcodes with:</td>
</tr>
<tr>
<td></td>
<td>• <strong>DNA libraries</strong>: Leave the Barcode field blank.</td>
</tr>
<tr>
<td></td>
<td>• <strong>RNA libraries prepared using the Ion Total RNA-Seq Kit v2</strong>: Select <strong>RNA_Barcode_None</strong> from the drop-down list. This will ensure that the proper trimming is performed on the resulting sequence when the RNA library does not have a barcode.</td>
</tr>
<tr>
<td><strong>Field name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Monitor</td>
<td>Set thresholds for Bead Loading, Usable Sequence, and Key Signal. In the Ion Proton™ Torrent Browser Monitor ➤ Runs in Progress tab, an alert is displayed if the values for a run fall below the selected thresholds.</td>
</tr>
<tr>
<td>Reference Library</td>
<td>Select a reference library uploaded to the Ion Proton™ Torrent Server, if any.</td>
</tr>
<tr>
<td>BED files</td>
<td>Select the Target Regions or HotSpot Regions BED file on the Ion Proton™ Torrent Server, if any.</td>
</tr>
<tr>
<td>Plugins</td>
<td>Select the appropriate plugins for your application.</td>
</tr>
<tr>
<td>Project</td>
<td>Select or add a project within which to group your run data. You can include runs in multiple projects, and remove runs from a project at any time.</td>
</tr>
<tr>
<td>Export</td>
<td>If installed and enabled, and you want to upload data to the Ion Reporter™ Software, select the Ion Reporter™ Uploader.</td>
</tr>
<tr>
<td>Planned Run Name</td>
<td>Enter a name for the run.</td>
</tr>
</tbody>
</table>
| Sample Name    | • If Ion Reporter™ Uploader is enabled, enter each sample name and select the appropriate values for workflow, relation, relation role, and set ID.  
• If Ion Reporter™ Uploader is not enabled, enter the sample name or names separated by commas. |
Clean and Initialize the Ion Proton™ Sequencer

**Ion Proton™ Sequencer reagent positions**

Front row: dGTP, dCTP, dATP, and dTTP Reagent Tubes (instrument positions R1-R4)  
Back row: Wash 1, Wash 3, Clean 1, and Clean 2 Reagent Tubes (instrument positions W1, W3, C1, and C2)  
Also shown: Wash 2 Bottle (W2) and waste container

**Before you begin**

Prepare a stock of 1 M NaOH daily by diluting 10 M NaOH with 18 MΩ water directly from the purification system. Do not use water that has been collected or stored in any other containers. You will need 32 µL for each initialization, 1 mL for each chlorite cleaning, and ~60 µL for each chip preparation (to prepare 600 µL of 0.1 M NaOH).
Clean the Ion Proton™ Sequencer

Materials required

• 18 MΩ water (prepared and used directly from a water purification system, for example, Elga® PURELAB® Flex 2 Water Purification System)
• Two 140-mL Reagent Tubes (provided with kit; label the Reagent Tubes C1 and C2 before use)
• Collection tray (provided with the Ion Proton™ Sequencer)
• Cleaning chip (leave chip on the instrument during cleaning)
  
  Note: A cleaning chip is a used chip that you designate for cleaning. You can use this chip for cleaning for up to 1 week.
• Used Sippers (from previous run or provided with the instrument)
• For chlorite cleaning only:
  – Ion Proton™ Cleaning Tablet (provided with kit)
  – 2 Reagent Tubes designated for chlorite cleaning (Relabel used C1 or C2 Reagent Tubes for this purpose)
  – 1 M NaOH
  – 0.22-µm or 0.45-µm vacuum filtration system and filters

Cleaning schedule

Run the cleaning program with 18 MΩ water or chlorite solution before each initialization according to the following schedule. Cleaning takes ~30 minutes.

<table>
<thead>
<tr>
<th>Clean with</th>
<th>Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>18 MΩ water</td>
<td>• Before each initialization.</td>
</tr>
<tr>
<td></td>
<td>• (Recommended) After the last run of the day if the instrument will not be used within 72 hours after the last run (for example, clean after the last run before a 3-day weekend).</td>
</tr>
<tr>
<td></td>
<td>• Before shutting the instrument down for an extended period.</td>
</tr>
<tr>
<td>Chlorite solution</td>
<td>• Once a week (unless the instrument has not been used since the last chlorite cleaning, in which case, clean with 18 MΩ water before using).</td>
</tr>
<tr>
<td></td>
<td>• If reagents have been left on the instrument for more than 48 hours (for example, over the weekend).</td>
</tr>
</tbody>
</table>
### Clean and Initialize the Ion Proton™ Sequencer

**18 MΩ water cleaning**

**IMPORTANT!** For the following steps, use 18 MΩ water directly from the purification system. Do not use water that has been collected or stored in any other containers.

1. Select **Clean** on the touchscreen Main Menu, then follow the instructions on the touchscreen to perform the cleaning procedure.

2. When prompted, orient the cleaning chip with the notch in the bottom-front corner, place the chip in the chip clamp, then push the metal tab back until it clicks to engage the clamp.

   **Note:** Do not force the chip into the clamp. If the chip does not fit easily in the clamp, confirm that the notch is oriented as shown in the following photos.

3. When prompted, remove all of the Reagent Tubes and the Wash 2 Bottle:
   - Remove and discard all eight 140-mL Reagent Tubes.

   **Note:** If necessary, you can reuse the same C1 and C2 Reagent Tubes for multiple cleanings for up to 1 week. If you reuse the C1 and C2 Reagent Tubes, make sure the tubes are correctly labeled, and cap the tubes when they are not installed on the instrument.

   - Remove the Wash 2 Bottle, discard the liquid, and **save the bottle for reuse in initialization**.

   - Remove and replace the Sippers in the C1 and C2 positions.

   **IMPORTANT!** Leave all other Sippers in place, these are used during cleaning and initialization.

4. Remove the Waste Container, empty the waste, replace the container on the instrument, then press **Next**.

5. Rinse the C1 and C2 Reagent Tubes twice with ~100 mL of 18 MΩ water.

6. Add 100 mL of 18 MΩ water to the C1 and C2 Reagent Tubes and install them into the C1 and C2 positions of the Ion Proton™ Sequencer.

7. Place the collection tray on the instrument, direct all Sippers into the collection tray, then press **Next**.

8. When cleaning is finished, press **Next** to return to the Main Menu.

Proceed to “Initialize the Ion Proton Sequencer” on page 24.
Chlorite cleaning

Perform chlorite cleaning weekly, and as directed in “Cleaning schedule” on page 21.

**IMPORTANT!** For the following steps, use 18 MΩ water directly from the purification system. Do not use water that has been collected or stored in any other containers.

1. Fill a glass bottle with 1 L of 18 MΩ water and add an Ion Proton™ Cleaning Tablet (chlorite tablet). Allow the tablet to completely dissolve (~10 minutes).

2. When the tablet has dissolved, add 1 mL of 1 M NaOH and filter the solution using a 0.22-µm or 0.45-µm filter. Use the chlorite solution within 2–3 hours and discard any unused solution after this time.

3. Select Clean on the touchscreen Main Menu, then follow the instructions on the touchscreen to perform the cleaning procedure.

4. When prompted, secure a cleaning chip in the chip clamp.

5. When prompted, remove all of the Reagent Tubes and the Wash 2 Bottle:
   - Remove and save the C1 and C2 Reagent Tubes for use with chlorite solution. (Label these tubes for chlorite cleaning only and discard after the chlorite cleaning cycle is completed; do not use these tubes for 18 MΩ water cleaning.)
   - Remove and discard all other 140-mL Reagent Tubes.
   - Remove the Wash 2 Bottle, discard the liquid, and save the bottle for reuse in initialization.
   - Remove and replace the Sippers in the C1 and C2 positions.

**IMPORTANT!** Leave all other Sippers in place, these are used during cleaning and initialization.

6. Remove the Waste Container, empty the waste, replace the container on the instrument, then press Next.

7. Add 100 mL of filtered chlorite solution to the two Reagent Tubes designated for chlorite cleaning.

8. On the Ion Proton™ Sequencer, install the tubes containing chlorite solution in the C1 and C2 positions.

9. Place the collection tray on the instrument, then direct all Sippers into the collection tray. Press Next to begin cleaning.

10. When cleaning is finished press Next to return to the Main Menu.

11. Remove and discard the Reagent Tubes used for chlorite solution from the C1 and C2 positions.

   **Note:** If necessary, you can reuse the same Reagent Tubes for multiple chlorite cleanings for up to 1 month. If you reuse the chlorite cleaning tubes, make sure the tubes are correctly labeled, and cap the tubes when they are not installed on the instrument. Do not reuse chlorite cleaning tubes for 18 MΩ water cleaning.
12. Rinse new C1 and C2 Reagent Tubes twice with ~100 mL of 18 MΩ water.

13. Fill the C1 and C2 Reagent Tubes with 100 mL of 18 MΩ water, then install the tubes into the C1 and C2 positions of the Ion Proton™ Sequencer.

14. Select Clean on the touchscreen Main Menu, then press Next to advance through the instrument prompts until the cleaning procedure begins. This post-chlorite cleaning step with 18 MΩ water ensures that any residual chlorite solution is flushed from the Ion Proton™ Sequencer.

15. When post-chlorite cleaning is complete, press Next to exit Cleaning and return to the Main Menu.

Proceed to “Initialize the Ion Proton Sequencer” on page 24.

Initialize the Ion Proton™ Sequencer

Initialize the instrument before each run. Initialization takes ~90 minutes.

Note: For additional information about Initialization, see Appendix A, “Troubleshooting”.

Materials provided in the kit

- 140-mL Reagent Tubes for W1, W3, and dNTP reagents
  
  Note: Use the labels provided with the kit to label the Reagent Tubes.
- Sippers
- Ion PI™ dGTP, dCTP, dATP, and dTTP
- Ion PI™ W2 Solution
- Ion PI™ 1X W3 Solution

Other materials and equipment

- Used or new chip

IMPORTANT! Use a chip from a sequencing run performed in the last two days. If no sequencing was performed in the last two days, use a new chip for initialization and sequencing. Do not use a cleaning chip for initialization.

- 18 MΩ water
- 1 M NaOH (prepared fresh daily)
- Ice
- Nitrogen gas tank, tube, and flow meter
- 25-mL or 50-mL serological pipette
- Filtered pipette tips and pipettes
- Vortex mixer
- Microcentrifuge
- (If necessary to adjust pH manually) pH meter, multipoint pH calibration reagents, pH probe, and probe stand, magnetic stirrer, stir bar, and squirt bottle
IMPORTANT! Begin your run within 4 hours after initialization.

IMPORTANT! Handle nucleotides carefully to avoid cross-contamination. Always discard gloves after removing used Sippers from the Ion Proton™ Sequencer in order to avoid cross-contamination of the nucleotides. Always discard gloves after handling concentrated dNTP stocks. Barrier tips are required for all dNTPs pipetting steps.

- Replace the Reagent Tubes and Sippers every time you initialize.
- Replace the Wash 2 Bottle after 4 initializations.
- Check for updates to the Torrent Suite and Ion Proton™ Sequencer software, and install the updates if available.

Before you begin

- Remove the dNTP stock solutions from the freezer and begin thawing on ice.
- Check the tank pressure for the nitrogen gas. When the tank pressure drops below 500 psi, change the tank.

Begin the initialization

1. Remove the Sippers from the W1, W2, and W3 positions. Do not remove the used Sippers from the dNTP ports until instructed to do so.

2. Select Initialize on the touchscreen Main Menu.

3. When prompted, scan or enter the W2 Solution barcode, or select the Ion PI™ Sequencing 200 Kit v2 from the drop-down list.

   Note: If you are using a barcode scanner, press Enter barcode in the touchscreen before scanning the W2 Solution barcode.

4. Secure a used chip in the chip clamp, then press Next.

   The system verifies the gas pressure. If the gas pressure is low, press Yes to retry gas-pressure verification. If the gas pressure remains low, see “Error Message: Confirm Instrument Has Gas Pressure” on page 40.

5. Press Next to begin the initialization.

Begin preparing Wash 2 bottle

IMPORTANT! For all the following steps, pour the 18 MΩ water directly from the purification system into the Wash 2 Bottle. Do not use water that has been collected or stored in any other containers.

1. Upon first use of the Wash 2 Bottle, add 1920 mL of 18 MΩ water to the bottle, mark the fill line, and empty the bottle.

2. Rinse the Wash 2 Bottle (2 L) three times with 200 mL of 18 MΩ water.

3. Insert the nitrogen gas tube into the empty Wash 2 bottle, set the flow meter to 0.5 liters per minute (lpm), and flow gas into the bottle for 5 minutes to purge carbon dioxide from the container.
Prepare and install the Wash 1 and Wash 3 Reagent Tubes

While the Wash 2 Bottle is purging, prepare the Wash 1 and Wash 3 Reagent Tubes.

1. Add 32 µL of 1M NaOH solution to the Wash 1 Reagent Tube.
2. Add 40–50 mL of the 1X W3 Solution from the kit to the Wash 3 Reagent Tube, measured using a serological pipette or graduated cylinder.
3. Install new Sippers (short Sippers with blue Luer lock connectors) in the W1 and W3 positions. **Do not let the new Sippers touch other Sippers on the instrument or any other surfaces.**
4. Install the W1 and W3 Reagent Tubes into the W1 and W3 positions of the Ion Proton™ Sequencer, place the collection tray beneath dNTP Sippers, then press Next.

IMPORTANT! Load the Wash 2 Bottle as quickly as possible to prevent atmospheric carbon dioxide from reducing the pH of the Wash 2 Bottle solution.

Finish preparing Wash 2 Bottle and install

1. Shut off the gas.
   **Note:** Keep the gas flowing to the Wash 2 Bottle until you are ready to immediately prepare and load the bottle on the instrument.
2. Extend the water spigot from the water purification system into the neck of the Wash 2 Bottle, then add water to the fill line marked on the bottle (1920 mL).
3. Add 80 mL of Ion PI™ W2 Solution to the Wash 2 Bottle using a serological pipette.
4. Cap the bottle securely and invert five times to mix.

**IMPORTANT!** To prevent air exchange, keep the bottle tightly capped until it is attached to the Ion Proton™ Sequencer.

5. Follow the on-screen prompts to install a new Sipper (long Sipper with gray Luer lock connector) in the cap for the Wash 2 Bottle. **Do not let the Sipper touch any surfaces.**
6. Immediately attach the prepared Wash 2 Bottle and tighten the cap. Ensure that the cap is screwed on tightly, then place the Wash 2 Bottle in the reagent compartment before you continue.
7. Direct sippers to the collection tray, then press **Next** to continue initialization. The Ion Proton™ System tests the tubes for leaks, fills the Wash 1 Reagent Tube, adjusts the pH of the Wash 2 Solution, then dilutes the Wash 1 Reagent Tube solution to the optimal concentration for the sequencing run. This procedure takes ~40 minutes.
   **Note:** If a leak or error occurs during the automatic pH process, see Appendix A, “Troubleshooting”.
Prepare and install the Reagent Tubes with dNTP solutions

1. After each deoxyribonucleotide (dNTP) stock solution has thawed, vortex to mix and centrifuge to collect the contents. Keep dNTP stock solutions on ice throughout this procedure.

2. Use the labels provided with the kit to label four new 140-mL Reagent Tubes as dGTP, dCTP, dATP, and dTTP.

3. After the wash solutions have initialized, follow the on-screen prompts to remove the used dNTP Sippers and the collection tray.

4. Using new gloves, attach a new Sipper (short, blue Luer lock) to each dNTP port. Do not let the Sippers touch any surfaces.

5. Using a new filtered pipette tip, carefully transfer 20 µL of dGTP stock solution into the bottom of the appropriate Reagent Tube, then attach the dGTP Reagent Tube to the Ion Proton™ Sequencer in the correct position (front left row) and firmly tighten.

6. Similarly, prepare and install the dCTP, dATP, and dTTP Reagent Tubes by transferring 20 µL of each dNTP stock solution to the corresponding Reagent Tube. Use a new pipette tip for each nucleotide. Make sure to install the Reagent Tubes in the correct order (dGTP, dCTP, dATP, and dTTP from left to right when facing the instrument), then press Next.

7. Confirm all Reagent Tubes and Wash 2 Bottle are tightly secured, then press Next.

The Ion Proton™ Sequencer checks the pressure of the Reagent Tubes and Wash 2 Bottle, then adds W2 Solution to each dNTP Reagent Tube.

Note: If a tube or bottle leaks, you are prompted to check that it is tightly attached to the instrument. If it continues to leak, replace it. If you replace the tube or bottle but the instrument does not pass the leak check, contact Technical Support.

8. At the end of initialization, the Ion Proton™ Sequencer measures the pH of the reagents.
   - If every reagent is in the target pH range, a Passed screen is displayed. Press Next to return to the Main Menu. Proceed to Chapter 4, “Load the Ion PI Chip v2 and start the sequencing run”.
   - If a Failed screen appears, see “Error message: Reagent pH: Failed; Reagent pH is displayed” on page 46.
Load the Ion PI™ Chip v2 and start the sequencing run

Guidelines for handling and loading chips

**Chip handling guidelines**

**IMPORTANT!** To avoid possible damage to the chip due to electrostatic discharge, ground yourself before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

**Note:** When handling chips, as a best practice, use a bare hand to touch the grounding surface and then use the opposite hand to insert or remove the Ion PI™ Chip v2 from the chip clamp.

To place a chip in the chip clamp for cleaning, initialization, or sequencing:

- Pull the metal tab forward to release the chip clamp.

If necessary, remove the chip currently in the clamp.
Place the appropriate chip in the chip clamp with the chip notch in the bottom-front corner.

**Note:** Do not force the chip into the clamp. If the chip does not fit easily in the clamp, confirm that the notch is oriented as shown in the photo.

Push the metal tab back until it clicks to engage the clamp.

**Chip loading guidelines**

When loading a sample:
- Place the chip on a flat, stable surface such as a benchtop.
- Pipet the sample into the chip loading well.
When injecting reagents or buffers:

- Place the chip on a flat, stable surface such as a benchtop.
- With the pipette tip at a 90° angle to the chip, press the tip firmly into the circular loading port, and apply gentle pressure between the pipette tip and chip.
- Pipet carefully to avoid introducing bubbles into the chip flow cell (see example with introduced air bubbles on right).
- After each injection, remove the expelled liquid from the exit port, opposite the loading port.

### Materials required

**Materials provided in the Ion PI™ Sequencing 200 Kit v2**

- Ion PI™ Control Ion Sphere™ particles
- Ion PI™ Annealing Buffer
- Ion PI™ Sequencing Primer
- Ion PI™ Loading Buffer
- Ion PI™ Sequencing Polymerase
- Ion PI™ Chip Preparation Solution

**IMPORTANT!** For Ion AmpliSeq™ Exome libraries, use the following components included in the Ion AmpliSeq™ Exome Kit (Cat. no. 4487084):

- Ion PI™ Loading Buffer XT instead of the Ion PI™ Loading Buffer with all lots of Ion PI™ Reagents XT Kit except for lots 1407166 and 1422806. For lots 1407166 and 1422806, use the Ion PI™ Loading Buffer included in the Ion PI™ Sequencing 200 Kit v2.
- Ion PI™ Sequencing Polymerase v3 instead of Ion PI™ Sequencing Polymerase for all Ion PI™ Reagents XT Kit lots.

- Ion Proton™ Chip Adapters

**Other required materials and equipment**

- Ion PI™ Chip v2 Kit (Cat. no. 4482321)
- Enriched template-positive Ion PI™ ISPs prepared with the Ion PI™ Template OT2 200 Kit v2
- 0.1 M NaOH (~600 µL per chip, prepared fresh daily)
- Standard laboratory vacuum line or vacuum pump
- Liquid trap
• Tygon® tubing

  **Note:** As needed to connect laboratory vacuum to liquid trap and liquid trap to P200 pipette tip.

• Rainin® Pipet-Lite XLS LTS with RFID pipette and tips

• P200 and P10 pipette and filtered tips

• Triton® X-100

• Aluminum heat block, capable of reaching and maintaining 50°C

• Vortex mixer

• Molecular-biology grade nuclease-free water

• 100% isopropanol

• Thermal cycler with heated lid (programmed at 95°C for 2 minutes and 37°C for 2 minutes)

• Ion Chip™ Minifuge (Cat. no. 4479672 or 4479673) for loading sample on chip equipped with Ion Proton™ Rotor and Buckets (Cat. no. 4482578)

### Before you begin

**IMPORTANT!** Use enriched, template-positive Ion PI™ ISPs prepared using the Ion PI™ Template OT2 200 Kit v2.

**IMPORTANT!** For best results, begin your run within 4 hours after initialization completes.

- Equilibrate the Ion PI™ Chip Preparation Solution to room temperature for at least 20 minutes before use. Keep the tube tightly capped immediately before and after use.

- Pre-heat an aluminum heat block to 50°C.

- Thaw the Sequencing Primer.

- Prepare 2% Triton® X-100 as described in “Prepare 2% Triton” on page 60.

- Prepare the following stock solutions fresh weekly or more frequently as needed:
  - **50% Annealing Buffer:** In a 1.5-mL tube, combine 0.5 mL of Ion PI™ Annealing Buffer with 0.5 mL of nuclease-free water (you need 360 µL of 50% Annealing Buffer for each run).
  - **Flushing solution:** In a 1.5-mL tube, combine 0.5 mL of 100% isopropanol with 0.5 mL of Ion PI™ Annealing Buffer (for use in “Flush the chip and load the Ion PI Sequencing Polymerase” on page 36; you need 200 µL of Flushing solution for each run).

**Note:** You can prepare multiple 1-mL aliquots of stock solutions at the same time, and store at room temperature. After opening an aliquot, use the contents within 1 week. Discard any opened, unused solution after 1 week.

- Check for updates to the Torrent Suite and Ion Proton™ Sequencer software, and install the updates if available.

- Before using the Ion Chip™ Minifuge for the first time, perform the procedures in “Set up and test the Ion Chip Minifuge” on page 61.
Prepare the template-positive Ion PI™ Ion Sphere™ Particles for sequencing

Add Ion PI™ Control Ion Sphere™ particles to the enriched ISPs

**IMPORTANT!** If you are performing an installation or troubleshooting run, do not use enriched ISPs. Follow the procedure in “Troubleshooting using the Ion PI Control Ion Sphere particles” on page 50 to prepare the Ion PI™ Control Ion Sphere™ particles for the installation or troubleshooting run.

1. Vortex the Ion PI™ Control Ion Sphere™ particles for 5 seconds, then centrifuge for 2 seconds before taking aliquots.

2. Add 5 µL of Ion PI™ Control Ion Sphere™ particles directly to the entire volume of enriched, template-positive ISPs in a 0.2-mL PCR tube (non-polystyrene), then pipet up and down to mix.

**IMPORTANT!** The Ion PI™ ISPs are difficult to see. To avoid aspirating the particles in the following steps, orient the PCR tube the same way each time when centrifuging so that it is easy to know where the pellet has formed, and remove the supernatant from the top down.

1. Centrifuge the enriched, template-positive ISPs for 5 minutes at 15,500 x g.

2. Carefully remove the supernatant without disturbing the pellet, leaving 10 µL of supernatant in the tube (visually compare to 10 µL of liquid in a separate tube).

3. Add 15 µL of Ion PI™ Annealing Buffer for a total volume of 25 µL.

4. Add 20 µL of Ion PI™ Sequencing Primer and confirm that the total volume is 45 µL. Add Ion PI™ Annealing Buffer if necessary to bring the total volume to 45 µL.

5. Briefly vortex to mix, then centrifuge briefly to collect the contents at the bottom of the tube.

6. Program a thermal cycler for 95°C for 2 minutes and then 37°C for 2 minutes, using the heated lid option.

7. Place the tube in the thermal cycler and run the program.

**IMPORTANT!** For Ion AmpliSeq™ Exome libraries, use Ion PI™ Loading Buffer XT, included in the AmpliSeq™ Exome Kit (Cat. no. 4487084), instead of Ion PI™ Loading Buffer.

8. After cycling, add 10 µL of Ion PI™ Loading Buffer, briefly vortex to mix, then centrifuge briefly to collect the contents at the bottom of the tube.

After cycling, the reaction can remain at room temperature while you proceed to “Prepare and calibrate the Ion PI Chip v2 for loading” on page 33.
Prepare and calibrate the Ion PI™ Chip v2 for loading

**Prepare the chip for loading**

**IMPORTANT!** To avoid possible damage to the chip due to electrostatic discharge, ground yourself before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

**IMPORTANT!** Wear gloves for the following steps. The Ion PI™ Chip Preparation Solution is a skin irritant.

1. Label a new Ion PI™ Chip v2 to identify the experiment, then place the chip on a stable surface such as a benchtop.
   
   **Note:** If the chip was not used to initialize the Ion Proton™ Sequencer, skip the next step.

2. If the chip was used to initialize the Ion Proton™ Sequencer, inject 100 µL isopropanol into the chip loading port, then inject 100 µL of nuclease-free water into the loading port and remove the expelled liquid from the opposite port. Repeat the water flush one more time and remove the expelled liquid.

3. Attach an Ion Proton™ Chip Adapter to the chip exit well (located on the side of the chip with the notched corner, opposite the loading port; see figure below). Press firmly to ensure the adapter is tightly engaged around the well.

4. Inject 200 µL of 100% isopropanol into the chip loading port, then remove the expelled liquid from the exit well fitted with the adapter.

5. Attach a P200 pipette tip to a vacuum line, insert the pipette tip into the chip loading port, and aspirate the isopropanol from the chip flow cell for 5–10 seconds. Inspect the chip to make sure it is dry.
   
   **Note:** Make sure that the Ion PI™ Chip Preparation Solution has completely equilibrated to room temperature before proceeding to the next step. Immediately re-cap the solution tube after use to prevent evaporation and exposure to air.

6. Inject 100 µL of Ion PI™ Chip Preparation Solution into the chip loading port, then remove the expelled liquid from the exit well.
   
   **Note:** Be careful not to introduce bubbles in the chip. If bubbles appear, repeat this wash step.

7. Place the chip on the flat surface of an aluminum heat block pre-heated to 50°C and incubate for 2 minutes.
Note: Place the chip on the side of the heat block that does not contain wells, as shown in the figure below.

8. Remove the chip from the heat block and place it on a stable surface such as a benchtop.

9. Inject 200 µL of 100% isopropanol into the chip loading port, then remove the expelled liquid from the exit well. Repeat the isopropanol flush one more time.

10. Inject 200 µL of nuclease-free water into the chip loading port, then remove the expelled liquid from the exit well.

11. Inject 200 µL of 0.1 M NaOH into the chip loading port, then remove the expelled liquid from the exit well.

12. Wait 1 minute, then inject 200 µL of nuclease-free water into the chip loading port and remove the expelled liquid from the exit well.

13. Repeat steps 4–12 two more times, for a total of three chip washes.

14. Inject 200 µL of 100% isopropanol into the chip loading port, then remove the expelled liquid from the exit well.

15. Pipet 100 µL of 100% isopropanol into the chip loading well (do not inject directly into the port), then remove the liquid from the same well. This step cleans any residue from the surface of the loading well.

16. Remove the Ion Proton™ Chip Adapter from the chip.

Optional: Store the prepared chip

The prepared chip can be stored for up to 24 hours before calibration and loading. To store the chip:

1. Attach a P200 pipette tip to a vacuum line, insert the pipette tip into the chip loading port, and aspirate the isopropanol from the chip flow cell for 5–10 seconds. Inspect the chip to make sure it is dry.

2. Place the dry chip back in its original anti-static bag and store at room temperature in the dark (for example, in the box that the chip came in).

3. When you are ready to calibrate and load the chip, inject 100 µL of 100% isopropanol into the chip flow cell, remove the expelled liquid from the opposite port, then proceed to the next section.
Calibrate the chip

1. Secure the prepared chip in the chip clamp.

2. Press Run in the Main Menu, then press Next and confirm that “Cleaning fluid lines” displays.
   The instrument begins cleaning the fluid lines, then begins chip calibration.

3. During calibration, observe the chip for leaks. If there is a leak, press the Abort button immediately to stop the flow to the chip, then see “Liquid in drip pan below chip clamp” on page 42.

   **IMPORTANT!** Never open the chip clamp during calibration.

4. When the chip passes calibration, remove the chip, and replace it with a cleaning chip to prevent backflow in the fluid lines.

   **Note:** If chip calibration fails, see “Error message: Failed: Reseat chip, then press Next to recalibrate” on page 45.

5. Inject 100 µL of nuclease-free water two times into the chip loading port. After each injection, remove the expelled liquid from the opposite port.

6. Inject 100 µL of isopropanol two times into the chip loading port. After each injection, remove the expelled liquid from the opposite port.

7. Aspirate the remaining isopropanol from the chip flow cell for 5–10 seconds. Confirm that the chip is dry.

   **Note:** To aspirate the isopropanol, attach a P200 pipette tip to a vacuum line, then place the pipette tip in the chip loading port.

Load the Ion PI™ Chip v2

Load the sample on the chip

1. Place the calibrated chip in the centrifuge bucket with the chip notch pointing out. Place a used chip in the opposite bucket with the chip notch pointing out.

2. Dispense the entire prepared sample (55 µL) into the chip loading well (not the chip loading port) of the calibrated chip.

   **Note:** Some sample enters the flow cell at this point by capillary action; the remaining sample is loaded into the flow cell during centrifugation.
3. Centrifuge the chip for 10 minutes in the Ion Chip™ Minifuge.

4. In a 1.5-mL tube, combine 45 µL of 50% Annealing Buffer with 5 µL of 2% Triton® X-100.

5. Create foam by injecting air into the 50-µL mixture from the previous step using a Rainin® SR-L200F pipette set to dispense 100 µL. Next, break the large bubbles into smaller bubbles by rapidly pipetting for ~5 seconds. Repeat this step one more time.

   Note: Do not over-inject the air; the final volume of foam should be approximately 250 µL.

6. Place the chip on a stable surface such as a benchtop, then inject 100 µL of foam into the chip loading port. Remove the expelled liquid from the opposite port.

7. Place the chip back in the centrifuge bucket with the chip notch pointing out, then dispense 55 µL of 50% Annealing buffer into the chip loading well (not the chip loading port).

8. Centrifuge the chip for 30 seconds in the Ion Chip™ Minifuge.

9. Place the chip on a stable surface such as a benchtop. Remove the liquid that has accumulated in both of the chip loading wells.

10. Briefly "re-foam" the foam sample by pipetting rapidly for ~5 seconds, then inject 100 µL of foam into the chip loading port. Remove the expelled liquid from the opposite port.

11. Place the chip back in the centrifuge bucket with the chip notch pointing out, then dispense 55 µL of 50% Annealing buffer into the chip loading well (not the chip loading port).

12. Centrifuge the chip for 30 seconds in the Ion Chip™ Minifuge, then proceed to flushing the chip.

Flush the chip and load the Ion PI™ Sequencing Polymerase

1. Inject 100 µL of the Flushing solution into the chip loading port two times. After each injection, discard the solution that is expelled from the opposite port.
2. Inject 100 µL of 50% Annealing Buffer into the chip loading port three times. Do not introduce air bubbles. After each injection, remove the expelled liquid from the opposite port.

**IMPORTANT!** For Ion AmpliSeq™ Exome libraries, use Ion PI™ Sequencing Polymerase v3, included in the Ion AmpliSeq™ Exome Kit (Cat. no. 4487084), instead of Ion PI™ Sequencing Polymerase in the next step.

3. Combine 6 µL of Ion PI™ Sequencing Polymerase with 60 µL of 50% Annealing buffer, then inject 65 µL of this solution into the chip loading port. Avoid introducing air bubbles. Remove the expelled liquid from the opposite port.

4. Allow the chip to incubate for 5 minutes, then immediately proceed to “Select the planned run and start the sequencing run” on page 37.

---

**Select the planned run and start the sequencing run**

Complete “Prepare and calibrate the Ion PI Chip v2 for loading” on page 33 and “Load the Ion PI Chip v2” on page 35 before performing this procedure.

1. Secure the chip loaded with template-positive Ion PI™ ISPs in the chip clamp, close the chip compartment lid, then press Next.

2. In the drop-down list, select a planned run that you created in the Torrent Suite Software, then press Next.

   **Note:** You can also select **Planned Run (none)**, then enter your run information on the following screen, but selecting a predefined planned run is recommended.

3. Confirm the pre-populated settings are correct, or make changes using the buttons and drop-down lists if necessary.

   **Note:** If an error message appears, see “Error message: Not enough disk space for the necessary number of flows” on page 41.

4. Confirm that the reagent compartment door is closed, then press Next to begin the sequencing run.

   The system calibrates the chip (~1 minute), then begins the sequencing run. If chip calibration fails, see “Error message: Failed: Reseat chip, then press Next to recalibrate” on page 45.

   **IMPORTANT!** During a run, do not open the chip compartment lid or reagent compartment door, and avoid touching the instrument. Touching the instrument during the sequencing run may reduce the quality of the measurements.

When the run is complete, the touchscreen returns to the Main Menu. Use the Torrent Suite Browser to review your results. Clean and initialize the instrument before beginning a new run. See Chapter 3, “Clean and Initialize the Ion Proton Sequencer”. If the instrument will not be used for more than 3 days, see “Powering off” on page 58.
Troubleshooting

- Alarms and events ................................................... 39
- Status bar icon warnings .............................................. 40
- Instrument leaks ..................................................... 42
- Touchscreen ......................................................... 43
- Instrument error messages ............................................ 43
- Sample loading or sequencing ......................................... 49
- Troubleshooting using the Ion PI™ Control Ion Sphere™ particles ........... 50
# Alarms and events

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Red “Alarms” and/or “Events” message in Main Menu | • Software updates available  
• Connectivity issues  
• Instrument not detecting required files or hardware | Click on the red pop-up to see detailed messages.  
• If a message states “Newer Software Available”:  
  **IMPORTANT!** After updates are installed, the instrument must be restarted.  
  a. In the Main Menu, select **Options > Updates**.  
  b. Select the **Released Updates** checkbox, then press **Update**.  
  c. When installation is complete, follow the onscreen prompts to restart the instrument.  
  **Note:** In some cases, the instrument restarts automatically after software installation.  
• If a message states “No Connectivity to Torrent Server”, “No Connectivity to ftp server”, or “Network Manager not connected”, unplug and replug the ethernet cable, confirm that the router is operational, and verify that the network is up and running.  
• For any other messages:  
  a. Power off the instrument: In the Main Menu, select **Tools > Shut Down > Shut Down**.  
  b. Wait 30 seconds, then press the button on the front of instrument to power on the instrument.  
• If the red “Alarms” and/or “Events” message still appears in the main menu, contact Technical Support. |
## Status bar icon warnings

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Chip is secured in chip clamp, but chip icon indicates no chip detected | • Clamp is not engaged  
• Chip is not properly seated  
• Chip is damaged or dirty  
• Issue with chip socket | 1. Remove the chip from the chip clamp.  

**IMPORTANT!** Do not disengage the chip clamp if fluid is running to the chip. If you are currently running "Clean", "Initialize", or "Run", wait until the Next button on the touchscreen is active, or press Abort to return to the Main Menu before disengaging the clamp.  

2. Examine the chip for damage, such as hairline cracks, debris, or a detached flow cell.  
   • If the chip is damaged, insert a new chip in the chip clamp and engage the clamp, look at the chip icon to confirm the chip is detected, then press Next or make a selection in the Main Menu.  
   • If no damage can be observed, reinsert the chip in the chip clamp and engage the clamp, look at the chip icon to confirm the chip is detected, then press Next or make a selection in the Main Menu.  

3. If the chip is not detected by the instrument, there may be a problem with the chip socket. Contact Technical Support. |
| Error Message: Confirm Instrument Has Gas Pressure and/or Pressure icon indicates low gas pressure | Nitrogen gas cylinder may be turned off or empty | 1. Replace the gas tank if empty.  
2. If tank is not empty, confirm that the cylinder has at least 500 psi and 30 psi at the outlet of the regulator. Confirm that all valves between the cylinder and the Ion Proton™ Sequencer are open, then press Yes to retry verification of gas pressure.  
3. If the pressure test continues to fail, contact Technical Support. |
| Temperature icon indicates chip compartment temperature is out of range | Thermistor in chip compartment is damaged | Contact Technical Support.  

**Note:** Do not perform sequencing runs until this problem is corrected; non-optimal temperatures in the chip compartment may affect sequencing. |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message: Not enough disk space for the necessary number of flows</td>
<td>Data normally transfer automatically from the hard drive to the Ion Proton™ Torrent Server, however this may not happen in the case of:</td>
<td>1. Check for connectivity or network issues, for example, unplug and replug the ethernet cable, confirm that the router is operational, and verify that the network is up and running.</td>
</tr>
<tr>
<td>(The Ion Proton™ System hard drive does not contain enough space for the planned run) and/or</td>
<td>• Data transfer manually aborted by user • Issue with connectivity or network • Incorrect configuration of the Ion Proton™ Torrent Server</td>
<td>2. If in “Select Planned Run”, select Data Management in the touch screen, otherwise select Tools &gt; Data Management from the Main Menu.</td>
</tr>
<tr>
<td>Hard drive icon indicates hard drive is almost full</td>
<td></td>
<td>3. In the Data Management screen, select All, then review the runs. If there are runs that do not need to be transferred to the Ion Proton™ Torrent Server (for example test or aborted runs), select the checkbox next to the run names, then press Delete Sel.</td>
</tr>
<tr>
<td>On instrument analysis icon indicates error</td>
<td>Corrupt data files or file system, for example, SSD file array is corrupted</td>
<td>4. If there are runs that you do want to transfer, you may need to wait until connectivity is restored for the run to transfer and then autodelete.</td>
</tr>
</tbody>
</table>

1. Power off the instrument: In the Main Menu, select Tools > Shut Down > Shut Down.
2. Wait 30 seconds, then press the button on the front of the instrument to power on the instrument.
## Instrument leaks

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Liquid in drip pan below chip clamp | • Chip leak  
• Cracked chip  
• Chip clamp not closed properly  
• Leaky fluidic seal  
• Problem with the chip clamp or socket | 1. Press **Abort** to return to the Main Menu.  
2. Use a lab wipe to absorb the liquid in the drip pan.  
3. Open the chip clamp, remove the chip, and gently dab the chip with a lab wipe to dry.  
4. Look for damage to the chip, such as hairline cracks, debris, or a detached flow cell.  
   • If the chip is damaged, insert a new chip in the chip clamp and engage the clamp.  
   • If no damage can be observed, reinsert the chip in the chip clamp and engage the clamp.  
5. From the Main Menu, make the appropriate selection (**Clean**, **Initialize**, or **Run**) to start from the beginning of the process.  
6. If the leak persists, contact Technical Support. |
| Leak from bottom of instrument | • Waste container not emptied  
• Reagent tubes or bottle not securely installed | 1. Press **Abort** to return to the Main Menu.  
2. Clean up all liquid beneath the instrument.  
3. Confirm that the waste container is not overflowing, and empty if needed.  
4. Confirm that all Reagent Tubes and W2 Bottle are securely fastened on the instrument.  
5. If the leak is due to the waste container, Reagent Tubes, or W2 Bottle, re-start the procedure after correcting the problem.  
6. If there are no observable issues with the waste container, Reagent Tubes, or W2 Bottle, contact Technical Support. |
| Leak on instrument tubing (Fluid on fluid lines entering clamp) | Fluid lines running to chip clamp are damaged or are not secured correctly | Contact Technical Support. |
## Touchscreen

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touchscreen not registering input in correct location</td>
<td>Touchscreen needs to be calibrated</td>
<td>• In Main Menu, select <strong>Tools &gt; Screen Cal</strong>, then follow the onscreen prompts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the touchscreen continues to malfunction after Screen Cal, contact Technical Support.</td>
</tr>
<tr>
<td>Touchscreen inoperable</td>
<td>Damaged or defective touchscreen</td>
<td>Contact Technical Support.</td>
</tr>
</tbody>
</table>

## Instrument error messages

**Note:** Error messages are listed in alphabetical order.

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Error message: Added too much W1 to W2   | • Poor water quality (18 MΩ water not used directly from water purifier, or exposed to air for too long)  
  • Too much W2 Solution used to prepare Wash 2 Bottle  
  • Incorrect solution added to the Wash 2 Bottle  
  • Too little NaOH added to Wash 1 Reagent Tube  
  • Damaged chip | 1. Confirm high water quality and correct preparation of the 1 M NaOH and Wash 2 Bottle.  
  2. If solution preparation is incorrect or water quality is poor, correctly prepare the solution(s) and/or use high-quality water.  
  3. Clean the instrument.  
  4. Repeat instrument initialization with fresh reagents and a new (unused) chip. (The new chip can be used for sequencing after initialization completes.)  
  **Note:** Once the system has added too much NaOH, the only recourse is to clean the Ion Proton™ Sequencer and restart initialization or to manually adjust the pH the W2 Solution (see “Manually adjust the pH of the W2 Solution” on page 59). |
| Error Message: Check Wash1 for leaks       | • W1 Reagent Tube seal is not tight  
  • Tube may be damaged or defective        | 1. Remove the Wash 1 Reagent Tube, then replace in the W1 position.  
  2. Make sure that the tube is securely tightened (finger-tighten).  
  3. If the tube continues to leak, replace the tube.  
  4. If leak check continues to fail, contact Technical Support. |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Error Message: Check Wash2 for leaks | • Wash 2 Bottle seal is not tight  
• Bottle may be damaged or defective | 1. Remove the Wash 2 Bottle, then check the o-ring inside the Wash 2 Bottle lid. If there is any visible damage, contact Technical Support.  
2. If there is no visible damage to the o-ring, replace the Wash 2 Bottle on the instrument. Make sure that the bottle is securely tightened (finger-tighten).  
3. If the bottle continues to leak, replace the bottle.  
4. If leak check continues to fail, contact Technical Support. |
| Error Message: Check Wash3 for leaks | • W3 Reagent Tube seal is not tight  
• Tube may be damaged or defective | 1. Remove the Wash 3 Reagent Tube, then replace in the W3 position.  
2. Make sure that the tube is securely tightened (finger-tighten).  
3. If the tube continues to leak, replace the tube.  
4. If leak check continues to fail, contact Technical Support. |
| Error message: Chip reading inconsistent. Please replace chip and try again. | • pH response of the chip is not uniform or reliable  
• Ran out of W3 Solution or volume too low | 1. Verify that there is enough W3 Solution (approximately 50 mL) in the Wash 3 Reagent Tube and that the sipper is secure.  
2. If necessary, loosen the Wash 3 Reagent Tube, tighten the sipper, and add more W3 Solution to fill to 50 mL. Since the system pressurization gas flows when the reagent tube is loose, perform these operations as quickly as possible. (The gas is not harmful to the W3 Solution and is not a hazard.)  
3. If there is enough W3 Solution, replace the chip with a new (unused) one. Secure the chip in the chip clamp, then press Start.  
Note: The new chip can be used for sequencing after initialization completes. |
| Error Message: Confirm Instrument Has Gas Pressure and/or  
Pressure icon indicates low gas pressure (0 PSI) | Nitrogen gas cylinder may be turned off or empty | 1. Replace the gas tank if empty.  
2. If tank is not empty, confirm that the cylinder has at least 500 psi and 30 psi at the outlet of the regulator. Confirm that all valves between the cylinder and the Ion Proton™ Sequencer are open, then press Yes to retry verification of gas pressure.  
3. If the pressure test continues to fail, contact Technical Support. |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message: Failed: Reseat chip, then press Next to recalibrate</td>
<td>• Reagents not loaded</td>
<td>1. Confirm the required reagents are loaded on the instrument.</td>
</tr>
<tr>
<td>(New chip fails calibration before or after sample is loaded on chip.)</td>
<td>• Clamp is not engaged</td>
<td>2. Press Start to re-run calibration.</td>
</tr>
<tr>
<td></td>
<td>• Chip is not properly seated</td>
<td>3. If calibration fails, remove the chip from the clamp and look for damage to the</td>
</tr>
<tr>
<td></td>
<td>• Chip is damaged or dirty</td>
<td>chip, such as hairline cracks, debris, or a detached flow cell.</td>
</tr>
<tr>
<td></td>
<td>• Issue with chip socket</td>
<td>• If the chip is damaged, insert a new chip in the chip clamp and engage the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>clamp, then press Start to re-run calibration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If no damage can be observed, reinsert the chip in the chip clamp and engage the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>clamp, then press Start to re-run calibration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If calibration fails, run reagent check:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press Abort, select Tools &gt; Reagent Check, then press Start.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the reagent check fails, re-initialize the instrument before beginning a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sequencing run.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If reagent check passes, contact Technical Support.</td>
</tr>
<tr>
<td>Error message: Not enough disk space for the necessary number of flows</td>
<td>Data normally transfer automatically from the hard drive to the Ion Proton™</td>
<td>1. Check for connectivity or network issues, for example, unplug and replug the</td>
</tr>
<tr>
<td>(The Ion Proton™ System hard drive does not contain enough space for the</td>
<td>Torrent Server, however this may not happen in the case of:</td>
<td>ethernet cable, confirm that the router is operational, and verify that the network</td>
</tr>
<tr>
<td>planned run)</td>
<td>• Data transfer manually aborted by user</td>
<td>is up and running.</td>
</tr>
<tr>
<td>and/or</td>
<td>• Issue with connectivity or network</td>
<td>2. If in “Select Planned Run”, select Data Management in the touch screen, other-</td>
</tr>
<tr>
<td>Hard drive icon indicates hard drive is almost full</td>
<td>• Incorrect configuration of the Ion Proton™ Torrent Server</td>
<td>wise select Tools &gt; Data Management from the Main Menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. In the Data Management screen, select All, then review the runs. If there are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>runs that do not need to be transferred to the Ion Proton™ Torrent Server (for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>example test or aborted runs), select the checkbox next to the run names, then</td>
</tr>
<tr>
<td></td>
<td></td>
<td>press Delete Sel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If there are runs that you do want to transfer, you may need to wait until</td>
</tr>
<tr>
<td></td>
<td></td>
<td>connectivity is restored for the run to transfer and then autodelete.</td>
</tr>
<tr>
<td>Observation</td>
<td>Possible cause</td>
<td>Recommended action</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Error message: OVERSHOT TARGET PH: W2 pH = n.nn Failed | Auto-pH added more NaOH from the Wash 1 Reagent Tube to the Wash 2 Bottle than was needed | 1. Re-initialize the instrument using new reagents and a new chip (the chip can then be used for sequencing).  
2. Prepare 50 µL of 100 mM HCl. If you are in the auto-pH screen, press Overshoot. Follow the on-screen prompts to add 50 µL of 100 mM HCl to the W2 Solution. This will lower the pH of the W2 Solution. Press Restart to restart auto-pH.  
3. If the pH is consistent with the pH of the previous chip, manually adjust the pH of the W2 Solution (see “Manually adjust the pH of the W2 Solution” on page 59).  
   **Note:** If the Ion Proton™ System consistently overshoots the pH target, add 50 µL of 100 mM NaOH to the Wash 2 Bottle prior to installing it on the instrument. If you continue to experience overshoot issues even after the addition of the NaOH, contact Technical Support for further assistance. |
| Error message: Please insert a chip and press Start | Instrument cannot detect the chip in chip clamp | See recommended action for “Chip is secured in chip clamp, but chip icon indicates no chip detected” on page 40. |
| Error message: Reagent pH: Failed; Reagent pH is displayed | One or more reagents are not within the target pH | 1. Press Restart to restart auto pH and confirm the measurement.  
2. If any reagents fail, replace the chip with a new (unused) one. Insert the chip in the socket, then press Restart to restart auto pH (the new chip can be used for sequencing after initialization completes).  
3. If any reagents fail, clean and re-initialize the instrument with fresh reagents and a new chip.  
   **Note:** Message displays on touchscreen after Reagent Check at end of Initialization procedure. |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Error message: Reagent pH: Failed; Reagent pH is not displayed            | Chip did not calibrate               | 1. Remove the chip from the clamp and look for damage to the chip, such as hairline cracks, debris, or a detached flow cell.  
• If the chip is damaged, insert a new chip in the chip clamp and engage the clamp, then press Start to re-run reagent check.  
• If no damage is observed, reinsert the chip in the chip clamp and engage the clamp, then press Start to re-run reagent check.  
If reagent check fails again, replace the chip with a new (unused) one, then re-run reagent check (the new chip can be used for sequencing after initialization completes).  
2. If the reagent check continues to fail, contact Technical Support.     |
| Note: Message displays on touchscreen after Reagent Check at end of Initialization procedure. |                                      |                                                                                  |
| Error Message: Remove Conical tubes                                       | • dNTP Reagent Tube seal is not tight  
• Tube may be damaged or defective | 1. Remove and reinstall each dNTP Reagent Tube.  
2. Make sure that each tube is securely tightened (finger-tighten), the press OK to re-check pressure.  
3. If the error message persists, set up dNTPs in new tubes, secure new tubes on instrument, then press OK.  
4. If leak check continues to fail, contact Technical Support.             |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Error message: There may be a blockage or no NaOH in W1. Please check W1 and run line clear then try again | The waste lines may be blocked                     | 1. If you are in the auto pH screen, press Line Clear, otherwise select Tools > Auto pH > Line Clear from the Main Menu.  
2. Follow the on-screen prompts and use the syringe provided with the Ion Proton™ System.  
3. *(Optional)* To confirm the Line Clear procedure was successful, select Flow Check, then confirm that liquid flows from both waste lines.  
4. If the flow rates are still not normal, perform Line Clear one more time.  
5. If the line(s) remain blocked, contact Technical Support. Otherwise, if initialization was interrupted, restart initialization from the beginning. |
| No NaOH added to Wash 1 Reagent Tube, so chip does not detect large enough pH difference between the NaOH and W2 Solution |                                                                                       | 1. Remove the Wash 1 Reagent Tube, rinse with 18 MΩ water, then add 32 µL of 1M NaOH .  
2. Replace the Wash 1 Reagent Tube and securely tighten.  
3. Press Restart to restart auto-pH.                                                                                                           |
| Wash 1 or Wash 2 sipper is loose                                            |                                                                                       | 1. Loosen the Wash 1 Reagent Tube, tighten the sipper, then replace the Wash 1 tube and securely tighten.  
Tighten the sipper as quickly as possible to minimize the gas flow that occurs when the tube is removed. *(The gas is not harmful to the NaOH solution and is not a hazard.)*  
2. Loosen the Wash 2 cap and re-tighten the sipper.  
Tighten the sipper as quickly as possible to minimize the gas flow that occurs when the bottle is removed. *(The gas is not harmful to the W2 Solution and is not a hazard.)*  
3. Press Restart to re-start the auto-pH process.                                                                                             |
| Error message: UNDERSHOT TARGET PH: W2 pH = n.nn Failed                    | Auto-pH could not add enough Wash 1 to the Wash 2 before the maximum iterations, 10, occurred | 1. A blockage may have occurred. Follow the procedure for “Error message: There may be a blockage or no NaOH in W1. Please check W1 and run line clear then try again” on page 48.  
2. Press Restart to re-start auto-pH. If the “Undershot target pH” error appears again, replace the chip with a new (un-used) chip and restart auto pH.  
**Note:** The new chip can be used for sequencing after initialization completes.                                                             |
### Troubleshooting

**Sample loading or sequencing**

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message: W2 average not stable. Try reseating/replacing chip</td>
<td>The waste lines may be blocked. See first recommended action for “Error message: There may be a blockage or no NaOH in W1. Please check W1 and run line clear then try again” on page 48.</td>
<td></td>
</tr>
</tbody>
</table>
| Reading for W2 Solution is not stabilizing quickly enough | 1. Remove the chip from the clamp and look for damage to the chip, such as hairline cracks, debris, or a detached flow cell.  
- If the chip is damaged, insert a new chip in the chip clamp and engage the clamp (the new chip can be used for sequencing after initialization completes).  
- If no damage can be observed, reinsert the chip in the chip clamp and engage the clamp.  
2. Loosen the Wash 2 Bottle cap and re-tighten the sipper. Tighten the sipper as quickly as possible to minimize the gas flow that occurs when the bottle is removed. (The gas is not harmful to the W2 Solution and is not a hazard.)  
3. Press Restart to re-start auto-pH. If auto-pH fails even after running auto pH with a new chip, contact Technical Support and manually adjust the pH of the W2 Solution as described in “Manually adjust the pH of the W2 Solution” on page 59. | |
| Error message: W2 out of range       | • Chip measurements very unstable  
• Chip is damaged | See recommended actions for “Error message: W2 average not stable. Try reseating/replacing chip” on page 49. |

---

### Sample loading or sequencing

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Ion PI™ Control Ion Sphere™ particles are not present in the Test Fragment Report section of the run report and library sequencing is poor | • Poor chip loading  
• Ion PI™ Control Ion Sphere™ particles were not added to the sample  
• Chip is damaged  
• Instrument failure | 1. Confirm that the Ion PI™ Control Ion Sphere™ particles (included in this sequencing kit) were added.  
2. If controls were added, contact Technical Support. |
| Sample results were obtained, but poor or no results for Ion PI™ Control Ion Sphere™ particles in Test Fragment report | • No Ion PI™ Control Ion Sphere™ particles added to the sample  
• Ion PI™ Control Ion Sphere™ particles are past expiry date | Check Ion PI™ Control Ion Sphere™ particles expiry date. |
<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good conversion rate for Ion PI ™ Control Ion Sphere ™ particles, but poor sample loading and sequencing</td>
<td>Problems with library or template preparation</td>
<td>Verify the quantity and quality of the library and template preparations. See the Ion PI ™ Template OT2 200 Kit v2 User Guide (Pub. no. MAN0007624) for recommended quality assurance procedures.</td>
</tr>
</tbody>
</table>

**Troubleshooting using the Ion PI ™ Control Ion Sphere ™ particles**

**IMPORTANT!** To obtain the necessary volume of Ion PI ™ Control Ion Sphere ™ particles for installation or troubleshooting, use the control particles provided with the Ion PI ™ Controls Kit v2 (Cat. no. 4482414) instead of the Ion PI ™ Control Ion Sphere ™ particles provided with the Ion PI ™ Sequencing 200 Kit v2.

To prepare Ion PI ™ Control Ion Sphere ™ particles for an installation or troubleshooting sequencing run:

1. Create a planned run as described in Chapter 2, “Create a Planned Run”.
2. Clean and initialize the Ion Proton ™ Sequencer as described in Chapter 3, “Clean and Initialize the Ion Proton Sequencer”.
3. Prepare the Ion PI ™ Control Ion Sphere ™ particles for sequencing:
   a. Vortex the Ion PI ™ Control Ion Sphere ™ particles for 5 seconds, then centrifuge for 2 seconds before taking aliquots.
   b. Add 66 µL of Ion PI ™ Control Ion Sphere ™ particles to an empty 0.2-mL PCR tube (non-polystyrene).
   c. Add 150 µL of Ion PI ™ Annealing Buffer to the tube.
4. Continue to “Anneal Sequencing Primer to the enriched ISPs” on page 32, then follow the remaining procedures in Chapter 4, “Load the Ion PI Chip v2 and start the sequencing run” to calibrate and load a chip and start the sequencing run.
This appendix describes how to select and create barcode sets on the Ion Proton™ System for sequencing barcoded libraries.

Pre-installed barcode sets

The Torrent Suite Software includes the pre-installed barcode sets “IonXpress” and “IonXpressRNA.”

When setting up a Planned Run or performing a run, select the appropriate barcode set for your library type as follows:

- **DNA libraries:** Select the IonXpress barcode set, which includes all barcodes in the Ion Xpress™ Barcode Adapters 1–96 Kits.
- **RNA libraries prepared using the Ion Total RNA-Seq Kit v2:** Select the IonXpressRNA barcode set, which contains all 16 barcodes in the Ion Xpress™ RNA BC01–16 Kit (Cat. no. 4475485).

If you are not using barcodes:

- **DNA libraries:** Leave the Barcode field blank.
- **RNA libraries prepared using the Ion Total RNA-Seq Kit v2:** Select RNA_Barcode_None from the dropdown list. This will ensure that the proper trimming is performed on the resulting sequence when the RNA library does not have a barcode.

**IMPORTANT!** Do not edit, delete, or modify the pre-installed barcode sets.

Select a barcode set for a sequencing run

Select the barcode set in the Torrent Browser when planning the run. See “Create a planned run” on page 16.

Custom barcode sets

You can create custom sets of barcodes as comma-separated value (.csv) files, then load these sets onto the Torrent Server for use during sequencing runs.

To access the Ion Proton™ Torrent Server, you must have a username and password. For more information on working with custom barcode sets, refer to the Torrent Browser User Interface Guide.
Create and add a custom barcode set on the Ion Proton™Torrent Server

1. Create the Comma-Separated Variable (.csv) text file of the custom barcode set. The .csv text file can contain up to 384 barcodes.

2. To add the custom barcode set to the Ion Proton™Torrent Server, go to the Torrent Browser and click the Settings button on the right side of the window, then select References.

3. Scroll down to the DNA Barcodes section.

4. Click Add new DNA Barcodes.

5. Click the Download the example file link to download an example file to your computer.

6. On your computer, edit the .csv example file directly, or use Microsoft® Excel®, Notepad, or similar software to create a custom barcode set in the same format, with each barcode sequence listed on a separate line. The barcode list can contain up to 384 barcodes. Save the .csv file on your computer.

   **Note:** You can run fewer than 384 barcodes in a sequencing run; the Ion Proton™ System automatically detects and selects the barcodes used in the run from the selected set.

7. Back in the Torrent Browser, enter a name for the barcode set and click Browse to select the .csv file that you created.

8. Click Upload & Save. The barcode set file name is displayed in the Barcode panel.

Other barcode set options

**View a barcode set**

1. To view a barcode set, go to the Torrent Browser and click the References tab.

2. Scroll down to the Barcodes section and click on the barcode set name to display the list of barcodes in the set.
Delete a custom barcode set from the Ion Proton™ Torrent Server

1. To view the barcode set names, click the References tab in the Torrent Browser.
2. Scroll down to the Barcodes section and click the name of the barcode set that you want to delete.
3. In the barcode set page, click Delete Barcode Set, then click Yes to confirm the deletion.

Add a barcode to a custom barcode set

1. Open the Torrent Browser and click the References tab.
2. Scroll down to the Barcodes section and click the name of the barcode set to be edited.
3. Click Add Barcode. You see the new barcode window:

4. Complete the fields, then click Save Barcode.

Edit or delete a barcode from a set

1. Open the Torrent Browser, click Settings on the right side of the window, then select References.
2. In the Barcodes panel, click the file name of the barcode set to be edited.
3. Click the button under Action to edit or delete the panel.
   - To edit a barcode, change the barcode in the edit window, then click Save Barcode.
   - To delete a barcode from a set, click Delete, then click Yes to confirm the deletion.
Main menu

Clean, Initialize, and Run

The Clean, Initialize, and Run programs lead you through the necessary steps to prepare the instrument for sequencing and start a sequencing run.

- The Clean program can be used to perform either 18 MΩ water or chlorite solution cleaning. Cleaning must be performed before each initialization to ensure that the reagents from the previous run are cleared from the fluid lines. Abbreviated instructions are provided on the touchscreen; for the complete cleaning schedule and detailed instructions, see “Clean the Ion Proton Sequencer” on page 21.

- The Initialize program must be performed before each run to prepare the run reagents. The Initialize program walks you through the following steps:
  - Specifying the sequencing kit.
  - Setting up wash solutions. (After this step, the instrument adjusts and checks the pH of the Wash 2 Bottle solution.)
  - Setting up dNTPs. (After this step, the instrument checks the pH of all of the reagents.)

  Abbreviated instructions are provided on the touchscreen; for detailed instructions, see “Initialize the Ion Proton Sequencer” on page 24.

- The Run program walks you through steps leading up to and through sequencing, including:
  - Calibrating a chip before loading the sample on the chip.
  - Placing a loaded chip on the instrument.
  - Calibrating the loaded chip.
  - Selecting a planned run created in the Torrent Server Software.
  - Performing sequencing.

  For detailed instructions, see Chapter 4, “Load the Ion PI Chip v2 and start the sequencing run”
Options and Tools

- The **Options** menu gives you access to software updates. See “Update Ion Proton Sequencer software” on page 59 for details.
- The **Tools** menu gives you access to troubleshooting tools and to the instrument Shut Down and Reboot commands. See the following table for details.

### Table 3  Tools menu options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>When to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto pH</td>
<td>Adjusts the pH of the Wash 2 Bottle solution and checks the pH. This task is normally performed by the instrument as part of the Initialize program.</td>
<td>If directed to do so by Technical Support or as part of a troubleshooting procedure [see Appendix A, “Troubleshooting”].</td>
</tr>
<tr>
<td>Chip Cal</td>
<td>Runs the chip calibration portion of the Run program. Chip calibration is performed by the instrument as part of the Run program, both before and after sample is loaded on a chip.</td>
<td>If necessary to calibrate chips without using the Run program.</td>
</tr>
<tr>
<td>Data Mgmt</td>
<td>Allows you to manually delete run data or transfer the data to the server. Under normal conditions, run data is automatically transferred to the Ion Proton™ Torrent Server, then deleted from the instrument hard drive.</td>
<td>To troubleshoot data management issues. See “Error message: Not enough disk space for the necessary number of flows” on page 41.</td>
</tr>
<tr>
<td>Noise Screen</td>
<td>Provides real-time measurement of electrical noise readings on the chip.</td>
<td>For troubleshooting if directed to do so by Technical Support.</td>
</tr>
<tr>
<td>Pressure Cal</td>
<td>Allows you to calibrate the gas pressure after installing a new gas tank or to troubleshoot gas pressure error messages.</td>
<td>If seeing gas pressure error messages, see “Error Message: Confirm Instrument Has Gas Pressure” on page 40.</td>
</tr>
<tr>
<td>Reagent Check</td>
<td>Measures the pH of all reagents on the instrument. This task is normally performed by the instrument as part of the Initialize program.</td>
<td>If directed to do so by Technical Support or as part of a troubleshooting procedure [see Appendix A, “Troubleshooting”].</td>
</tr>
<tr>
<td>Screen Cal</td>
<td>Calibrates the touchscreen.</td>
<td>If the touchscreen is not registering pressure in the correct location. See “Touchscreen not registering input in correct location” on page 43.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Access to “Shut Down” and “Reboot” commands. <strong>Note:</strong> It is not necessary/recommended to shut down the instrument overnight or over the weekend. If necessary to shut down the instrument, see “Powering off” on page 58.</td>
<td>If directed to do so as part of a troubleshooting procedure.</td>
</tr>
</tbody>
</table>

### Chip Status icon

The chip status icon in the lower-left corner of the screen tells you that the chip is communicating with the instrument and alerts you to chip issues. Shortly after you
secure a chip in the chip clamp, the chip status should update to "Ready". If the in-
strument does not detect the chip, see “Chip is secured in chip clamp, but chip icon
indicates no chip detected” on page 40.

<table>
<thead>
<tr>
<th>Ready</th>
<th>Online</th>
<th>Imaging</th>
<th>Sleeping</th>
<th>No chip detected</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Ready icon]</td>
<td>![Online icon]</td>
<td>![Imaging icon]</td>
<td>![Sleeping icon]</td>
<td>![No chip detected icon]</td>
</tr>
</tbody>
</table>

**Touchscreen gauges**

Press the Gauges icon in the lower right corner of the touchscreen to show or hide the
instrument gauges.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Instrument gas pressure icon]</td>
<td>Instrument gas pressure. The expected value is 10.50 psi during cleaning and initialization, and 8.0 during a sequencing run. If the icon is red, see &quot;Error Message: Confirm Instrument Has Gas Pressure&quot; on page 40.</td>
</tr>
<tr>
<td>![Chip compartment temperature icon]</td>
<td>Chip compartment temperature. The expected value when the lid is closed is 35.00 C. If the icon is red, see &quot;Temperature icon indicates chip compartment temperature is out of range&quot; on page 40.</td>
</tr>
<tr>
<td>![Percent instrument hard drive and SSD in use icon]</td>
<td>Percent instrument hard drive and SSD in use. If the icon is red, see &quot;Error message: Not enough disk space for the necessary number of flows&quot; on page 41.</td>
</tr>
<tr>
<td>![On-instrument analysis icon]</td>
<td>On-instrument analysis. indicates on-instrument analysis is in progress. indicates no current on-instrument analysis. If the icon displays a red &quot;X&quot;, see &quot;On instrument analysis icon indicates error&quot; on page 41.</td>
</tr>
</tbody>
</table>

**Alarms/Events pop-up**

If the red Alarms/Events pop-up appears, press the pop-up to see detailed messages. To troubleshoot alarms and events, see “Red "Alarms" and/or "Events" message in Main Menu” on page 39.
Supplemental Procedures

- Power instrument on or off ............................................ 58
- Update Ion Proton™ Sequencer software ................................. 59
- Manually adjust the pH of the W2 Solution .............................. 59
- Prepare 2% Triton .................................................... 60
- Set up and test the Ion Chip™ Minifuge ................................. 61

Power instrument on or off

Powering on

Note: If the instrument is powered on, and the touchscreen is blank, touch the screen to "wake" the touchscreen.

1. Locate the power switch on the back of the instrument, then power on the instrument.

2. Press the power button on the front of the instrument.
   When the instrument touchscreen Main Menu first comes up, it will appear dim. After a few minutes, the main menu will be brightly lit, indicating that the instrument is ready for use.

3. If reagents were left on the machine for more than 48 hours, and the Clean program was not run with 18 MΩ water before powering off, run the Clean program with chlorite before initializing the instrument and performing a sequencing run.

Powering off

It is not necessary to power off the instrument overnight or over the weekend. If the instrument will not be used for more than 3 days, then power off the instrument as follows:

1. If powering off for more than 3 days, run the Clean program with 18 MΩ water before powering off.

2. In the Main Menu, select Tools ► Shut Down ► Shut Down.
   
   Note: Select Tools ► Shut Down ► Reboot if you want the instrument to shut down and immediately restart.
**Update Ion Proton™ Sequencer software**

**IMPORTANT!** After updates are installed, the instrument must be restarted.

If an update to the Ion Proton™ Sequencer software is available, the red "Alarms and Events" pop-up appears in the touchscreen Main Menu to alert you. Click the red pop-up to see the detailed messages. If a message states *New Software Available*, update the software as follows:

1. In the Main Menu, select **Options › Updates**.
2. Select the **Released Updates** checkbox, then press **Check**.
3. When the message *Press Update to begin update process* appears, press **Update**.
   
   **Note:** If the message *All Software Current* appears, press **Back, Back** to return to the main menu.
4. When the message *Installing Completed* displays, follow the onscreen prompts to restart the instrument.
   
   **Note:** In some cases, the instrument restarts automatically after software installation.

**Manually adjust the pH of the W2 Solution**

**Materials and equipment needed**

- Orion® 3-Star Plus pH Benchtop Meter Kit or equivalent
- Nitrogen gas tank, tube, and flow meter
- 1 M NaOH (prepared fresh daily)
- Pipette tips and pipette
- Magnetic stirrer and stir bar
- 100 mM HCl
- Squirt bottle

If an error message during the automatic pH process indicates that there is a problem adjusting the pH of the W2 Solution, use the following procedure to manually adjust the pH of the W2 Solution in the Wash 2 Bottle.

1. Before proceeding, rinse an empty Wash 2 Bottle and have it ready next to the instrument. Also have an additional Wash 2 Bottle cap ready.

   **Note:** Gas will be flowing out of the Wash 2 cap, so perform the next steps as quickly as possible (flowing gas will not harm the W2 Solution, and is not a hazard).

2. Remove the Wash 2 Bottle attached to the instrument, and cap the bottle.
3. Secure the empty Wash 2 Bottle (from step 1) to the instrument. Do not remove the sipper. This bottle will contain the gas flowing out of the instrument while you adjust the pH of the W2 Solution and protect the sipper from contamination.

4. Move the Wash 2 Bottle containing the W2 Solution to the stir plate near the nitrogen gas tube.

5. Secure the gas tube so that it extends inside the mouth of the Wash 2 Bottle but not below the surface of the W2 Solution.

6. Set the gas flow to 0.5 lpm. Start mixing the W2 Solution fast enough for a small whirlpool to form.

7. Calibrate the pH meter using a three-point calibration. Rinse any buffering solution from the pH probe prior to preparing solutions.

8. Adjust the pH of the W2 Solution to 7.7 ± 0.1 by adding a small amount (approximately 1 µL) of freshly prepared 1 M NaOH to the solution, and then measuring the pH using the pH meter. Add small aliquots and allow the pH to equilibrate before adding more.

   **Note:** If the pH rises above 7.8, use 100 mM hydrochloric acid (HCl) to readjust the pH to 7.7 ± 0.1.

9. When the pH is stable, turn off the gas, remove the gas line, and cap the Wash 2 Bottle.

10. Move the bottle to the instrument, remove the empty Wash 2 Bottle from the instrument, and place the sipper inside the Wash 2 Bottle containing the pH-adjusted solution.

11. Secure the cap firmly. Press **Next** to exit the automated pH check and continue with instrument initialization.

---

**Prepare 2% Triton**

**Materials and equipment needed**

- Triton® X-100
- P1000 pipette and tips
- Razor blade
- Pipette tips and pipette
- Nuclease-free water
- ≥10-mL tube

Trition® X-100 is extremely viscous and difficult to pipet at 100% concentration. To prepare 2% Triton® X-100, first prepare a 10% stock following the steps described below.

1. Cut ~3 mM off the end of a P1000 pipette tip using a razor blade; the wider opening will make it easier to pipet 100% Triton® X-100. Be careful not to squish the tip when cutting.
2. Add 4.5 mL of nuclease-free water to a ≥10-mL tube.

3. Fully submerge the cut pipette tip in the Triton® X-100 and slowly aspirate 500 µL. Do not remove the tip from the Triton® while aspirating, to avoid getting air in the tip.

4. Very slowly add the 500 µL of Triton® to the 4.5 mL of water. The Triton® will stick to the wall of the tip, but slow pipetting will ensure that all of the liquid is expelled.

5. Pipet the solution up and down a few times to ensure that all of the Triton® has been flushed from the tip.

6. Vortex the solution for a few minutes until the Triton® is fully dissolved. Droplets of Triton® will be visible in the solution if not fully dissolved.

7. After the 10% Triton® X-100 has been prepared, combine 200 µL of the 10% solution with 800 µL of nuclease-free water to make 1 mL of 2% Triton® X-100 solution.

8. Vortex to fully dissolve. The 10% and 2% stocks of Triton® X-100 may be stored under the same conditions as the 100% stock.

Set up and test the Ion Chip™ Minifuge

Before using the Ion Chip™ Minifuge (Cat. no. 4479672 or 4479673) for the first time:
- Install the Ion Proton™ Rotor and Buckets (Cat. no. 4482578).
- Test the minifuge to confirm that no liquid is lost during centrifuging.

Install the Ion Proton™ Rotor and Buckets

1. Grasp the existing rotor and pull straight up to remove the rotor from the motor shaft.

2. Press the Ion Proton™ Rotor down onto the motor shaft to install.
3. Tighten the set screw with a 1.5-mm hex wrench.

4. Install the two buckets. Position the buckets with the larger semi-circular cut-outs facing out, and ensure that the buckets hang freely.
Test the Ion Chip™ Minifuge

1. Prepare 2 previously-used chips:
   a. Inject 100 µL isopropanol two times into the loading port of each chip. After each injection, remove the expelled liquid from the opposite port.
   
   b. Aspirate the remaining isopropanol from the chip flow cells for 5–10 seconds. Confirm that the chips are dry.
      
      Note: To aspirate the isopropanol, attach a P200 pipette tip to a vacuum line, then place the pipette tip in the chip loading port.

2. Place the two chips prepared in step 1 in the centrifuge buckets, with the chip notch pointing out. Add 55 µL nuclease-free water to each chip loading well (do not inject into the chip loading port).

3. Centrifuge for 5-10 seconds, then examine each chip.
   
   Note: A small volume of liquid will remain in the loading well; this is normal.
   
   The flow cell in each chip should be completely filled with liquid with no air bubbles.
   
   • If the chips are NOT completely filled, contact Technical Support.
   • If the chips ARE completely filled: Centrifuge the chips for an additional 10 minutes, then check the chips again for air bubbles, especially near the inlet and outlet ports. After 10 minutes, if the chips are:
      
      – Still completely filled: The centrifuge is ready to use for Ion PI™ Chip v2 loading.
      
      – If chips have air bubbles: Contact Technical Support.
WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user documentation may result in personal injury or damage to the instrument or device. Ensure that anyone using this product has received instructions in general safety practices for laboratories and the safety information provided in this document.

- Before using an instrument or device, read and understand the safety information provided in the user documentation provided by the manufacturer of the instrument or device.
- Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use appropriate personal protective equipment (gloves, gowns, eye protection, etc). To obtain SDSs, see the “Documentation and Support” section in this document.

Equipment use

The Ion Proton™ System is for performing sequencing of amplified DNA, and should only be used for life science research applications. The Ion Proton™ System should only be used by professionals trained in laboratory techniques and who have studied the instructions for use of this instrument. If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

IMPORTANT! If you use and/or install the Ion Proton™ System in an unspecified manner, you may impair the protection provided by the equipment.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey important safety information. In this document, the hazard symbol is used along with one of the following user attention words:

- **CAUTION!** – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.
- **WARNING!** – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.
- **DANGER!** – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury.
<table>
<thead>
<tr>
<th>Conformity symbols on this instrument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Conformity mark symbol" /></td>
<td>Indicates conformity with safety requirements for Canada and U.S.A.</td>
</tr>
<tr>
<td><img src="image" alt="Conformity mark symbol" /></td>
<td>Indicates conformity with European Union requirements for safety and electromagnetic compatibility.</td>
</tr>
<tr>
<td><img src="image" alt="Conformity mark symbol" /></td>
<td>Indicates conformity with Australian standards for electromagnetic compatibility.</td>
</tr>
</tbody>
</table>

**Safety alerts on this instrument**

Additional text may be used with one of the symbols described above when more specific information is needed to avoid exposure to a hazard. See the following table for safety alerts found on the instrument.
<table>
<thead>
<tr>
<th>English</th>
<th>French translation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION!</strong> Hazardous chemicals. Read the Safety Data Sheets (SDSs) before handling.</td>
<td><strong>ATTENTION!</strong> Produits chimiques dangereux. Lire les fiches signalétiques [FS] avant de manipuler les produits.</td>
</tr>
<tr>
<td><strong>CAUTION!</strong> Hazardous waste. Refer to SDS(s) and local regulations for handling and disposal.</td>
<td><strong>ATTENTION!</strong> Déchets dangereux. Lire les fiches signalétiques [FS] et la réglementation locale associées à la manipulation et à l’élimination des déchets.</td>
</tr>
</tbody>
</table>
Some of the accessories provided as part of the instrument system are not designed or built by Life Technologies Corporation. Consult the manufacturer’s documentation for the information needed for the safe use of these products.

**Instrument safety**

**General**

⚠️ **CAUTION!** Do not remove instrument protective covers. If you remove the protective instrument panels or disable interlock devices, you may be exposed to serious hazards including, but not limited to, severe electrical shock, laser exposure, crushing, or chemical exposure.

⚠️ **CAUTION!** Solvents and Pressurized fluids. Wear eye protection when working with any pressurized fluids. Use caution when working with any polymeric tubing that is under pressure:

- Extinguish any nearby flames if you use flammable solvents.
- Do not use polymeric tubing that has been severely stressed or kinked.
- Do not use polymeric tubing with tetrahydrofuran or nitric and sulfuric acids.
- Be aware that methylene chloride and dimethyl sulfoxide cause polymeric tubing to swell and greatly reduce the rupture pressure of the tubing.
- Be aware that high solvent flow rates (~40mL/min) may cause a static charge to build up on the surface of the tubing and electrical sparks may result.

**Electrical**

⚠️ **WARNING!** Ensure appropriate electrical supply. For safe operation of the instrument:

- Plug the system into a properly grounded receptacle with adequate current capacity.
- Ensure the electrical supply is of suitable voltage.
- Never operate the instrument with the ground disconnected. Grounding continuity is required for safe operation of the instrument.

⚠️ **WARNING!** Power Supply Line Cords. Use properly configured and approved line cords for the power supply in your facility.

⚠️ **WARNING!** Disconnecting Power. To fully disconnect power either detach or unplug the power cord, positioning the instrument such that the power cord is accessible.
Cleaning and decontamination

⚠️ CAUTION! Cleaning and Decontamination. Use only the cleaning and decontamination methods specified in the manufacturer's user documentation. It is the responsibility of the operator (or other responsible person) to ensure the following requirements are met:

- No decontamination or cleaning agents are used that could cause a HAZARD as a result of a reaction with parts of the equipment or with material contained in the equipment.
- The instrument is properly decontaminated a) if hazardous material is spilled onto or into the equipment, and/or b) prior to having the instrument serviced at your facility or sending the instrument for repair, maintenance, trade-in, disposal, or termination of a loan (decontamination forms may be requested from customer service).
- Before using any cleaning or decontamination methods (except those recommended by the manufacturer), users should confirm with the manufacturer that the proposed method will not damage the equipment.

Gas safety

Verify that your installation room can accommodate gas cylinders.

⚠️ WARNING! Ion instrumentation should be installed and operated in a well-ventilated environment as defined as having a minimum airflow of 6-10 air changes per hour. Assess the need for ventilation or atmospheric monitoring to avoid asphyxiation accidents from inert gases and/or oxygen depletion, and take measures to clearly identify potentially hazardous areas through training or signage. Please contact your Environmental Health and Safety Coordinator to confirm that the Ion instruments will be installed and operated in an environment with sufficient ventilation.

⚠️ WARNING! Pressurized gas cylinders are potentially explosive. Always cap the gas cylinder when it is not in use, and attach it firmly to the wall or gas cylinder cart with approved brackets or chains.

⚠️ WARNING! Gas cylinders are heavy and may topple over, potentially causing personal injury and tank damage. Cylinders should be firmly secured to a wall or work surface. Please contact your EHS coordinator for guidance on the proper installation of a gas cylinder.

Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the standards and requirements for safety and electromagnetic compatibility as noted in the following table:

<table>
<thead>
<tr>
<th>Safety</th>
<th>Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reference</strong></td>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>IEC 61010-1</td>
<td>Safety requirements for electrical equipment for measurement, control, and laboratory use – Part 1: General requirements</td>
<td></td>
</tr>
<tr>
<td>EN 61010-1</td>
<td>Safety requirements for electrical equipment for measurement, control, and laboratory use – Part 1: General requirements</td>
<td></td>
</tr>
<tr>
<td>UL 61010-1</td>
<td>Safety requirements for electrical equipment for measurement, control, and laboratory use – Part 1: General requirements</td>
<td></td>
</tr>
<tr>
<td>CSA C22.2 No. 61010-1</td>
<td>Safety requirements for electrical equipment for measurement, control, and laboratory use – Part 1: General requirements</td>
<td></td>
</tr>
<tr>
<td>IEC 61010-2-010</td>
<td>Safety requirements for electrical equipment for measurement, control and laboratory use – Part 2-010: Particular requirements for laboratory equipment for the heating of materials</td>
<td></td>
</tr>
<tr>
<td>EN 61010-2-010</td>
<td>Safety requirements for electrical equipment for measurement, control and laboratory use – Part 2-010: Particular requirements for laboratory equipment for the heating of materials</td>
<td></td>
</tr>
</tbody>
</table>

### EMC

<table>
<thead>
<tr>
<th><strong>Reference</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 61326-1</td>
<td>Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements – Part 1: General Requirements</td>
</tr>
<tr>
<td>FCC Part 18 (47 CFR)</td>
<td>U.S. Standard “Industrial, Scientific, and Medical Equipment”</td>
</tr>
<tr>
<td>AS/NZS 2064</td>
<td>Limits and Methods of Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radiofrequency Equipment</td>
</tr>
<tr>
<td>ICES-001, Issue 3</td>
<td>Industrial, Scientific and Medical (ISM) Radio Frequency Generators</td>
</tr>
</tbody>
</table>

### Environmental design

<table>
<thead>
<tr>
<th><strong>Reference</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel read and practice the general safety guidelines for chemical usage, storage, and waste provided below, and consult the relevant SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see the “Documentation and Support” section in this document.
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing).
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood).
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the SDS.
- Handle chemical wastes in a fume hood.
- Ensure use of primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- After emptying a waste container, seal it with the cap provided.
- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure that the waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position.

<table>
<thead>
<tr>
<th>CAS</th>
<th>Chemical</th>
<th>Phrase</th>
</tr>
</thead>
<tbody>
<tr>
<td>26628-22-8</td>
<td>Sodium Azide</td>
<td>Sodium azide may react with lead and copper plumb-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ing to form highly explosive metal azides.</td>
</tr>
</tbody>
</table>

Specific chemical handling
Biological hazard safety

**WARNING! Potential Biohazard.** Depending on the samples used on this instrument, the surface may be considered a biohazard. Use appropriate decontamination methods when working with biohazards.

**WARNING! BIOHAZARD.** Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. All work should be conducted in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Safety equipment also may include items for personal protection, such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or goggles. Individuals should be trained according to applicable regulatory and company/ institution requirements before working with potentially biohazardous materials. Follow all applicable local, state/provincial, and/or national regulations. The following references provide general guidelines when handling biological samples in laboratory environment.

Documentation and Support

Obtaining Certificates of Analysis

The Certificate of Analysis provides detailed quality control and product qualification information for each product. Certificates of Analysis are available on our website. Go to www.lifetechnologies.com/support and search for the Certificate of Analysis by product lot number, which is printed on the box.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies Corporation, contact the chemical manufacturer.

Obtaining support

For the latest services and support information for all locations, go to:

www.iontorrent.com/support

At the website, you can:

• Access worldwide telephone and fax numbers to contact Technical Support and Sales facilities
• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support (ionsupport@lifetech.com)
• Search for user documents, SDSs, vector maps and sequences, application notes, formulations, handbooks, certificates of analysis, citations, and other product support documents
• Obtain information about customer training
• Download software updates and patches

Ion contact information

Web site: www.iontorrent.com
Ion community: ioncommunity.lifetechnologies.com
Support email: ionsupport@lifetech.com
Phone numbers
In North America: 1-87-SEQUENCE (1-877-378-3623)
Outside of North America: +1-203-458-8552

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies’ General Terms and Conditions of Sale found on Life Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have any questions, please contact Life Technologies at www.lifetechnologies.com/support.